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Who should read this document?
This document is intended for system administrators and clinic 
managers. It summarizes new features and describes the latest 
technical requirements for installing / upgrading to Centricity 
Practice Solution v12.0.12.

Before installing the release, read these release notes carefully and 
ensure that you have a verified backup.

If you are the clinic manager or practice 
administrator...

Carefully review and consider how changes in this release affect 
your practice setup and workflows. For questions about how these 
changes affect your practice,  contact Centricity Services at 
888.436.8491 option 1, or your Value Added Reseller (VAR). 

Download your complete documentation library from
engage.gehealthcare.com/community/en/cps/
documentation. 

Unzip to a folder on your system. When you open a 
document from the Centricity Document Library, you can 
click links to other guides to open them. Links do not work if 
you copy a document to a location outside the library folder.

!!! Important! The installation process for this release has 
changed from previous service packs. This release is a full 
upgrade, allowing you to upgrade directly from Centricity 
Practice Solution v7.1.2, v8.10, v9.x, v10.1.x, v11.x and 
v12.0.x.

Also, the installation process for JBoss and Service Layer 
has changed. During install and upgrade, a new Server 
Configurator utility automates the installation and 
configuration of your servers. See "Automated server 
configuration utility" on page 65. Click F1 on the 
Configurator for online help. 

A new version of the Calculating Hardware Requirements 
spreadsheet is available on the Service Portal at https://
engage.gehealthcare.com/community/en/cps/
documentation.
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If you are the system administrator...

Before installing or upgrading to this release, review the requirements documented in 
this release note and the system software/hardware requirements and installation/
upgrade instructions in your Centricity Practice Solution documentation library: 

 Configuring Environments for Centricity Practice Solution

 Installing Centricity Practice Solution

 Upgrading to Centricity Practice Solution

What’s new in this release?
Refer to "What’s New since 12.0" on page 39 to see all previous v12.0.x service pack 
fixes, Important Product Notifications, and new features/enhancements.

New features and enhancements

Install the latest Full Kbase and all subsequent Incremental updates 
When upgrading to a service pack, you should always apply ALL the latest full and 
incremental Knowledgebase updates. 

In this case, changes in this release to support coded values in CCDAs added two 
columns to the CQM_MAP table and are reflected in the latest Full Knowledgebase 
update. You need this update to see and test these changes.

1 Download and extract release files from the provided FilesAnywhere link and 
upgrade to SP12 as instructed.

2 Download and apply the latest Full Knowledgebase update available at https://
engage.gehealthcare.com/community/en/cps/downloads#knowledgebase. 

!!! Important! 3rd-party integration requirements. Some third-party 
applications may need to be reinstalled following this upgrade. Contact your 
providers to confirm support for integrations and any new configuration 
requirements.

EDI Plug-ins. Uninstall, reinstall, and reconfigure your EDI plug-ins after 
upgrading to Centricity Practice Solution v12.0.12. For information on 
installation and configuration, open the Support Document link next to your 
plug-in download link on the Product Updates page. If your plug-in includes 
compiled help, it is automatically extracted to the Client folder when you unzip 
the package.

https://engage.gehealthcare.com/community/en/cps/downloads#knowledgebase              
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Data mapping search now includes both start and end range options
New End Date can be set when searching for observation terms for a specified date 
range. SPR 63708, SPR 63706

New Active Reports to Activate/Inactivate Codes by Effective and 
Expiration Date
New ICD/CPT codes are often dispersed in advance of becoming effective with a 
future effective date. Two new reports in the Reports > Administrative folder can be 
used to set to inactive codes that are not yet effective and to set codes to active when 
the effective date is met:

 Inactivate Diagnosis Codes by Date report - This report finds diagnosis codes 
where your Input Date is earlier than Effective Date or after or the same as the 
code’s Expiration Date. An optional update query will inactivate all codes returned 
to prevent them from appearing in problem search results in the Chart module. 

If you perform optional inactivation, you must wait 15-20 minutes for problem 
search SOLR index files to be fully updated before expecting inactivated codes to 
disappear from problem search results.

 Activate Diagnosis Codes by Effective Date report - Use this report to find 
diagnosis codes where the Input Date you specify is earlier than code Effective 
Date. An optional update query will activate all codes returned to make them 
available to display in problem search results in the Chart module. 

If you perform optional activation, you must wait 15-20 minutes for problem 
search SOLR index files to be fully updated before using problem search to 
retrieve newly activated codes.
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Changes impacting Meaningful Use / Quality Measures reporting 
This section includes important information about fixes and enhancements impacting 
Meaningful Use Functional and Quality Measures reporting. in this release and in 
related Knowledgebase and Clinical Quality Reporting (CQR) web site updates.

Key fixes in the release

The following fixes have impacts on reporting workflows and measures you may be 
reporting on.

Clinical Quality Measure fixes
In most cases, the following fixes prevent a specified problem going forward. To 
correct issues in past patient records, you must apply the latest Knowledgebase 
updates and manually reset and rerun your CQM subscription for the reporting period 
before attestation.

Contact GE Support or your supporting VAR organization to configure and resend 
your data.

JSON data sent to CQR now includes event time and date
Previously, when multiple events were sent for the patient, CQR could not determine 
their order and used the order in which they were listed in the JSON file. As a result, 
occasionally Filed in Error events were treated as occurring after the event that was 
filed in error. Some clinical events were included that should have been removed and 
calculation results were incorrect. SPR 64674

Quality Reporting Community
Visit the new Quality Reporting Service Portal page regularly for new information, 
updated Quality Reporting guide and other documents, and webinars at https://
engage.gehealthcare.com/community/en/cps/quality-reporting-community.

Resending data for the current reporting period
Customers attesting for Meaningful Use or reporting for PQRS for the current 
reporting period will likely need to send revised data to CQR. 

Some changes noted below require resetting the Functional Measure and Clinical 
Quality Measure subscriptions to resend data for the current reporting period. 
Detailed impacts noted under "Key fixes in the release" on page 4. 

Contact GE Support or your supporting VAR organization to configure and 
resend your data.

View the following Webinar to learn what data update steps must be completed 
for PQRS and Clinical Quality / Functional measure reporting before you send 
final data to the CQR web site.

On the Centricity Services Portal, go to the View Past Webinars page at 
https://engage.gehealthcare.com/community/en/cps/webinars

Under MU/PQRS Preparation Series, MU and PQRS select the Webinar 
“Choosing a Service Pack and data submission requirements”. View the section 
entitled “Data Subscription Reset”.

https://engage.gehealthcare.com/community/en/cps/quality-reporting-community
https://engage.gehealthcare.com/community/en/cps/quality-reporting-community
https://engage.gehealthcare.com/community/en/cps/webinars
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Important Knowledgebase updates

This section includes information about Knowledgebase updates that work with this 
release to correct issues.

Knowledgebase update
This update includes/supports and requires the latest Knowledgebase updates: 

 Coded result attribute changes for CMS 2 Preventive Care and Screening: 
Screening for Clinical Depression and Follow-Up Plan. SPR 66111

 2015 Value Set changes for Clinical Quality Measures.

 A script to correct SNOMED diagnosis codes documented after SP10 and 
impacting CMS 56, CMS 61, CMS 64, CMS 66, CMS 90, CMS 117, CMS 132, CMS 135, 
CMS 140, CMS 144, CMS 145, CMS 149, CMS 165. Note that after upgrade to SP11 
or SP12, all codes entered after upgrade will also be correct. SPR 64275

Quality Reporting Guide

For the latest information on measure change details, see the latest posted version of 
the Quality Reporting Guide at https://engage.gehealthcare.com/community/en/
cps/quality-reporting-community.

Important Product Notifications

The following issues were resolved in this release:

Adding a LinkLogic relationship with a Patient ID set that is already 
associated with a relationship causes incorrect patient matching
GE recommends you set up a New External ID set for each import interface, not 
permitting duplicates. You should only share external ID sets across interfaces that 
generate unique patient IDs from the same source system. For example, Patient 
Registration and Scheduling are commonly managed in the same application. Do not 
share ID sets across interfaces if you are unsure if they are from a common origin. 
Sharing Patient ID sets across unrelated systems can cause incorrect patient 
matching and save imported data into the wrong charts. See the Managing Interfaces 
with Centricity Practice Solution guide for more information about patient matching 
using External ID sets.

Resolution: A warning message now displays when a LinkLogic relationship is added 
with a patient ID set that is already associated with a relationship. SPR 53712

Forms and text translations disappear from patient chart updates 
when two users are in the same patient document at the same time
If a user creates a document for a patient and adds a form and enters data, and then 
another user edits the same patient’s document on a different computer, they are 

The latest Knowledgebase updates are available at https://
engage.gehealthcare.com/community/en/cps/downloads#knowledgebase. 

!!! Administrators and Risk Managers should review these Important Product 
Notifications for details concerning resolved critical product functionality 
issues.

https://engage.gehealthcare.com/community/en/cps/downloads#knowledgebase              
https://engage.gehealthcare.com/community/en/cps/quality-reporting-community
https://engage.gehealthcare.com/community/en/cps/quality-reporting-community
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unable to see the information entered by the first user. If either user puts the 
document on hold and the first user re-opens the document only the changes made 
by the second user are shown.

Resolution: Data entered in either location is now seen by both users. SPR 53563

Documents open in a different chart while using RDP in a terminal 
services environment
While in a terminal services environment, using RDP, when opening or printing a 
document from the desktop, it occasionally opens or prints the wrong document or 
patient. 

Resolution: The correct document or patient now opens or prints when in a terminal 
services environment. SPR 55269

The previous patient’s information is duplicated in the current 
patient’s chart when using clinical content forms
While using a clinical content form, information such as orders, problem lists, etc. from 
the previous patient would occasionally appear in the current patient’s chart.

Resolution: The previous patient’s data no longer appears in the currently opened 
chart. SPR 57866

Form components are removed from the chart update when the 
blank line above it is selected and the Delete key is pressed
When a user highlights a form component and the blank line immediately above the 
form component in a chart note and the delete key is hit, the form component is 
remove from the chart note without an error message or warning. 

Resolution: An error message “This selection contains protected text - Text Protection 
Error” displays when attempting to delete a form component. SPR 60989

The patient banner updates, but the previously selected patient’s 
documents remain visible
Occasionally, when moving between patients, the banner and the patient documents 
did not match; the currently selected patient retains documents for the previous 
patient.

Resolution: This fix addresses most aspects of SPR 62422 and SPR 65552; the patient 
banner and documents should now both show the currently selected patient’s 
information. SPR 66511

Fixed issues
The following issues have been addressed in this release:

Administration
 Fixed an issue under Orders > Service providers where the list of providers did not 

scroll to view the entire list. SPR 63880

Billing
 Fixed an issue where problem and procedure codes were duplicated in billing. SPR 

64699
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Chart
 NG Feeds and G-Tube Feeds can now be selected as routes when adding a 

medication. SPR 66685

 Fixed an issue where, if an encounter form was set to automatically check 
“Medication list reviewed during this update”, the review was not being recorded 
correctly. SPR 66466

 Addressed specific workflows associated with SPR 62043 where, if the patient had 
entries in the Provider/User in the FLAGS.TOUSER, FLAGS.FROMUSER, and 
PERSON.RESPPROV fields, but the user was missing from the USR table, Null 
exceptions on INSURANC.PSISTATE,IMMUNIZATION.SERIES, the application would 
crash.   This resulted in the application crashing while attempting to add or modify 
a medication and Rx refills. SPR 66601

 Fixed and issue where the default print items for printing chart documents was 
incorrect. SPR 66239

 Fixed an issue where printing a form caused the application to freeze. SPR 66335

 Fixed an issue where diagnosis information was not saved correctly when a POA 
indicator was included. SPR 66336

 Added two scripts and multiple reports to address and issue where document 
signing was occasionally not signing all Clinical List items. See "Unsigned Clinical 
List Reports" on page 12 for details on the scripts and reports and how to run 
them. SPR 66205, SPR 66207, SPR 66208, SPR 66211, SPR 66212

 Fixed an issue where new encounters were slow to open, especially on large 
patient charts. This fix includes an overloading data symbol LIST_OBS, adding a 
fifth argument “docDetails”:

The syntax is: LIST_OBS(observation,status,list_type,format, [docDetails])

The new argument “docDetails” is a Boolean type and is set to TRUE by default. 
When set to FALSE, unnecessary reads to the Document table are eliminated; 
therefore, the following data from the Document table will not be returned: 
Location of Care, Document Type, Visible Document ID. This argument is used only 
for the delimited format. 

For example:

LIST_OBS("MEDS REVIEW", "Signed", "Delimited", "value", 
FALSE)

Returns:

Done^03/14/2016^2:11:57 PM^Harry S. Winston MD^Harry S. 
Winston MD^^^^^^

SPR 65737

 Fixed an issue where users were getting an alert “Another user is editing text, try 
again later.” SPR 61045

 The Immunization and Medication Administration custom list editors now require 
and check for a valid NDC code Format. The Immunization custom list editor 
includes an NDC Format field on the Edit Vaccine window that allows user to 
specify the standard NDC format 5-4-2 or 4-4-3 when entering an 11-character 
NDC code. Default format is 5-4-2. 

The Medication Administration custom list editor specified the format required on 
the NDC Code entry field.
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The system validates the code with the format before saving it to the database. If 
the field is blank, you see an “Invalid NDC code” error. If you enter less than or 
more than 11 characters or include characters other than hyphens, you see the 
message: “Invalid NDC code. Please enter a valid NDC format (e.g. 5-4-2 or 4-4-3).” 

SPR 63012, SPR 63014

 Fixed an issue where the “Previous” button was not working properly when 
navigating between encounter forms. SPR 65856

 Addressed an issue when working in an encounter form and a message opened 
and was dismissed, the encounter form was resizing to the default size. SPR 
66185

 Fixed an issue where loading a new encounter took more time than expected, 
especially in large charts. SPR 65738

 Fixed an issue where entering vaccines from the Immunization Management form 
encountered a space limitation and did not appear in the chart, and led to a script 
error. SPR 61667

 Fixed an issue where the Potential Diagnosis list in Update Orders was showing as 
not ICD-10 specific, even if they had a valid ICD-10 code. SPR 66163

 Fixed an issue where procedure codes built on the Problem Custom List were not 
visible when adding new problems. SPR 65669

 Fixed an issue where adding an adverse reaction to an immunization created 
marked the immunization as “removed” in the Clinical List Changes. This fix relies 
on an update to the Immunization Management HTML form that was released in 
March 2016. Make sure you have the Immunization Management HTML Form 
Patch for CCC Basic v1.4 installed. The patch can be downloaded from the 
Centricity Services web site at: https://engage.gehealthcare.com/community/en/
cps/clinical-content. SPR 62173

 Fixed an issue where data from certain forms were not showing in the chart. SPR 
65675

 Addressed an issue where, if the application is published and used as a terminal 
service, CPS crashed when opening a Phone Note. SPR 63691

 Fixed an issue where the Refresh button wasn’t working on CCC forms. SPR 64054

 Fixed an issue where the dosing calculator was giving incorrect dosing 
information for certain medications for pediatric patients. SPR 64780

 Fixed an issue where the ICD-10 code E11.51 was duplicating in the Update 
Problems window when the application was refreshed. SPR 65629

 Columns in the Chart Desktop now retain their size if the window is closed and 
reopened. SPR 52648

 Addressed multiple issues with the scrollbar and cursor jumping to the top of the 
screen. SPR 63553, SPR 64219, SPR 45236

The vaccine administration form displays the NDC number in read only 
format. If you notice an error during an update, note the correction in the 
comment field for the administration.

NDC number corrections must be done in the custom list editor. After 
upgrade, review your custom lists for incorrectly formatted NDC numbers.

https://engage.gehealthcare.com/community/en/cps/clinical-content
https://engage.gehealthcare.com/community/en/cps/clinical-content
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 Fixed an issue where a warning was given when adding problems that a duplicate 
problem was being added even though the ICD-10 codes were different. SPR 
64042

 Fixed an issue where users were unable to select “Additional Signature Required” 
on a Custom Document type if the permission had been given and then removed. 
SPR 64128

 Addressed multiple issues where inserting forms into an encounter, the new form 
did not get inserted directly below the current form. SPR 64307, SPR 55244

 Addressed multiple issues where clicking to go to another form component from 
the CCC Basic encounter type opened a different component. SPR 58736, SPR 
60368

 Addressed multiple issues where old flags were causing the application to crash. 
SPR 60101, SPR 61330

 Fixed an issue to improve signing transaction protection. Clinical data (such as 
obs terms, orders, meds, allergies, directives, and the document itself) is not 
signed if signing a document failed. SPR 63017

 Fixed an issue where the Immunization Custom List Editor was not pre-populating 
the VIS Date for Vaccine Groups. SPR 63549

 Fixed an issue where non-strength medications in the reference list were not 
indicating drug interactions when prescribed. SPR 63637

EDI
 Fixed an issue when using Real Time Eligibility in Registration, a warning about 

“EDI Tracking Enabled” appears across the title of Chart. SPR 58161

General
 Orders that have been sent are no longer marked as unsigned by the Unsigned 

Clinical List reports. SPR 66767

 The Unsigned Clinical List reports no longer give an error if a the clinical date of a 
document is very old. SPR 66769

 Fixed an issue where CCDAs were not resent after the Unsigned Clinical List repair 
script if the corrupted item was from an HTML form. SPR 66772

 The Unsigned Clinical List Auto-Repaired report now shows which problem an 
assessment was for. SPR 66773

 Fixed performance issues while running the historical repair script after the 
nightly job. SPR 66779

 Fixed an issue where the local printer was being used for task-based printing 
rather than the printer indicated for that task. SPR 66668

 Fixed an issue where Dragon crashed when turning on the microphone. If you had 
previously changed the settings of the Dragon nsapp.ini file for emrTer from 9 to -
1, you will need to change it back to 9:

a Close Dragon. 

b Depending on your version, navigate to: 
C:\ProgramData\Nuance\NaturallySpeaking12 
or 
C:\ProgramData\Nuance\NaturallySpeaking11 

c Locate and open the file nsapp.ini.

d Use Ctrl+F to search for “EmrTer”.
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e Change the value of this entry to 9, then save and close the file.

f Relaunch Dragon and test.

This change will need to be made on every machine where Dragon is installed 
and you previously changed the setting. SPR 66690

 Reverted a fix for SPR 63017 in Service Pack 11 that attempted to improve signing 
transaction protection, where clinical data (such as obs terms, orders, 
medications, allergies, directives) was signed, but the document was not signed if 
signing it failed. SPR 65931

 Fixed an issue where inactive users were not showing in selection lists, even 
though “Show Inactive Items” was checked. SPR 65579

 Fixed an issue where only 200 active users were visible when selecting a provider. 
SPR 65346

Meaningful Use
 Fixed an issue where CareTransIn obs values were not being counted correctly in 

the denominator for the Medication Reconciliation functional measure. A 
database repair script has also been added to ensure that any existing 
CareTransIn obs values are counted correctly. SPR 65762, SPR 65921

 Fixed an issue where low numerators may have presented for CPOE Laboratory 
and Radiology orders in workflows that included non-credentialed and 
credentialed users making numerous clinical list changes within a document. SPR 
65408

 Fixes an issue where documents co-signed after the nightly JSON extract were 
not associated with the EP unless they were appended. SPR 63961

MIK
 Addressed an issue where, if a CPS database is licensed only for PM and not 

Chart, the Patient Merge HL7 ADT^A18 message fails to be sent. Previously, an 
error appeared in the MIK Event Log: “Send done, status=MIK_ERROR, msg = 
Cannot find any information about patientId mapping for the destination 
LinkLogic.” SPR 63825

Orders
 Fixed an issue where, if a Problem was added to the chart twice from different 

lists, an incorrect Diagnosis displayed in Update Orders. SPR 64778

 Fixed an issue where the application would freeze intermittently when placing 
orders. SPR 65418

 Fixed an issue where the ORDER NEW data symbol did not trigger when the 
document was signed so the EMR Link Process Order Form did not trigger that the 
order was signed. SPR 65375

 Fixed an issue where orders did not show on the Orders tab when using a Service 
Provider with the NO FORM setting enabled. SPR 65378

 Fixed an issue where test order forms printed blank when signing orders at the 
end of an update. Orders that have previously been processed incorrectly due to 
this issue may reappear in the document; however, they are not duplicates and 
will not be sent out again. SPR 65353

 Fixed an issue where duplicate order numbers were occasionally generated. SPR 
47153
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 Fixed an issue where the printer designated as the default printer for Orders was 
not being used and the printer was defaulting to the printer selected for “All Other 
Documents”. SPR 61752

 Fixed an issue where orders were printed to the default printer and not the one 
selected in “Task Based Printing”. SPR 65281

Performance
 Performance and stability enhancements. SPR 64310, SPR 64114, SPR 64152, SPR 

64744, SPR 64818, SPR 65495, SPR 61023, SPR 65758

 Updated Configurator to better handle setting up smaller systems. SPR 66153

 This patch includes performance enhancements that optimize the core stored 
procedure (processworkstalog) used when refreshing. SPR 66369 

Prescriptions
 Fixed an issue where medications were disappearing on the Prescription Refill 

form when the MEL symbol MED_LIST_CHANGES(“DELIMITED”) was used in the 
text component and Prescriptions form. SPR 57312

Problem search
 Fixed multiple issues where Advanced Problem Search gave errors when 

searching for specific problems. SPR 65944, SPR 65945, SPR 65946, SPR 65966, 
SPR 65362

 If you enter a search term mapped as a keyword to a problem code in your most 
recently used problems list (Smart List), any codes mapped to that keyword will 
appear in search results at the top of the list. For example, if you type the keyword 
“dm2” and you have problem AODM in your most recently used problem list, then 
that code will appear at the top of the list followed by other problems mapped to 
diabetes.

Problem codes on the Smart List that match the entered search term either by 
keyword or description are listed first. Matches to codes that are not on the Smart 
List are listed next (up to list maximum of 20). SPR 64142

 When a code has been marked as inactive in the Diagnosis table it is now 
considered non-billable and is not be displayed in Smart List search results. SPR 
64471

Reports
 Updated the Problems Report to include ICD-10 codes. SPR 64168

 Fixed an issue where the Diagnosis search stopped working in reports if the 
caption of the “config.xml” file was changed. SPR 62562
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Schedule
 Schedule limits now honored in the Appointment Search with new override 

options. If you define daily limits for the day for Appointment Types or Financial 
Class Limits in the schedule template for a provider and then search for that type 
of appointment, only available slots in days where the daily limit has not been met 
will display. Previously, all available slots displayed and you had to select a slot to 
find out of that day's limit had been met. 

With proper security, users may override template restrictions on daily limits by 
selecting one of the following options on the appointment search window. These 
options are useful when no results are returned for a schedule that contains limits 
and a user needs to override the limit restriction: 

 Override search results to return dates where Appointment Type limits have 
been met 

 Override search results to return dates where Financial Class limits have been 
met

SPR 64294

Settings
 Added the setting “EnableNewSigningTransactScope” to the file mlsetvar.txt to 

adjust the scope of signing transactions to address an issue where forms with 
long document temp variables (over 4000 characters), gave an application error 
while documenting an office visit, and pending observation terms were SIGNED at 
the moment of the error, even though the note remained unsigned. Set the 
variable to TRUE to enable the new transaction signing scope, or FALSE to turn it 
off. SPR 64383

Unsigned Clinical List Reports

An issue was detected that document signing is occasionally not signing all Clinical 
List items (problems, medications, prescriptions, immunizations, in-office medication 

Implementation tip. If you set up and save default searches, make sure 
the search name reference any appointment or financial class limits you 
included.

Example 1: If Dr Jones limits the number of new patient appointments, 
name the default appointment search criteria “Jones New OB limits 3”.

Example 2: If Dr Jones also limits BCBS to four appointments a day, name 
the search criteria “Jones NewOB limit3 BCBS limit4”.
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administration, allergies, advanced directives, care plans, observation terms, and 
orders). In such cases, these Clinical List items related to a patient chart are not 
displayed to the user even though they are saved in the database. SPR 65656

This package includes five reports to determine if any patient charts were affected by 
this issue and a repair script. SPR 66205, SPR 66207, SPR 66208, SPR 66211, SPR 
66212

 Summary by Year - This report is run for a year range (in yyyy format) and 
Locations of Care specified by the user and outputs the year; number of 
providers; number of LOCs; and the number of affected documents by provider, 
LOC, and year. See the sample report on page 33 for a preview of what this report 
will look like.

 Summary by Provider - This report is run for a year range (in yyyy format) and 
Locations of Care specified by the user and outputs the provider name, LOC, year, 
and number of affected documents. See the sample report on page 34 for a 
preview of what this report will look like.

 Detailed Patient Clinical List Items - This report is run for a date range specified 
by the user and outputs the LOC, patient name, patient ID, clinical date, doc ID, 
clinical list item, and value. This report can be sorted by patient name. See the 
sample report on page 36 for a preview of what this report will look like.

 Unsigned Clinical List Items - Not Auto-Repaired - This report is run for a date 
range specified by the user and outputs a list of clinical items that were not able 
to be repaired automatically and require user intervention to correct. It outputs 
the Patient ID, clinical date, document summary, clinical list item, and details of 
the unsigned item. This report is sorted by the signing provider and Patient ID. See 
the sample report on page 37 for a preview of what this report will look like.

 Unsigned Clinical List Items - Auto-Repaired - This report is run for a date range 
specified by the user and displays a list of clinical items that were able to be 
repaired automatically by the included database script. This report depends on 
the repair script having been run for the same date range. It outputs the Patient 
ID, clinical date, document summary, clinical list item, and details of the unsigned 
item. This report is sorted by the signing provider and Patient ID. This report can 
be run as often as needed to keep track of what has been repaired. See the 
sample report on page 38 for a preview of what this report will look like.

 The repair script operates in two modes:

 Historical mode, to be run manually and repair existing instances of 
unsigned clinical list items. This script will automatically correct observations, 
assessments, medications, medication administration requests, medication 
administration records, immunizations, care plans, and family health history 
records. 

The script will not auto-repair prescriptions, problems, directives, allergies, or 
orders, but will send a Care Alert to the patient chart that items need to be 
corrected manually. These are being held for manual correction to avoid 
duplications, and insure that unmonitored items like prescriptions and 
charges are not generated without professional review and decisions.

Depending on the size of your database and the date range you choose, 
this script may take a while to run. You should schedule a downtime to run 
the script to reduce the performance impact for your users.
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 Nightly mode, is set to run automatically on an ongoing basis to repair any 
new instances of unsigned clinical items. This script automatically corrects 
observations, assessments, medications, medication administration 
requests, medication administration records, immunizations, care plans, 
family health history records, problems, directives, and allergies. 

The script will not auto-repair prescriptions or orders, but will send a Care 
Alert to the responsible provider that items need to be corrected manually. As 
with the historical script, prescriptions, orders to outside providers, or charges 
need professional review and decisions.

Suggested workflow

1 Run the Summary by Year, Summary by Provider, and Detailed Patient Clinical 
List Items reports to determine how far back you need to run the repair script for. 
See "Running the reports" on page 15 for details on how to run these reports.

2 Run the SQL script FixInconsistentDataCPS.sql to automatically repair historical 
documentation-only clinical items (such as observations) for the time period 
determined in step 1. Set the end date to the present date to avoid missing any 
documents that may have had their dates updated by Meaningful Use patches. 

a On a machine that has access to the database, open SQL Server 
Management Studio and navigate to <Staging Area>\SS\Utilities\ and open 
FixInconsistentDataCPS.sql. 

b Change the start and end date in the script to the date range you want to 
repair.

c Execute the script.

3 Run the Unsigned Clinical List Items - Auto-Repaired report. This report lists all 
the clinical list items that were automatically corrected.

4 Run the Unsigned Clinical List Items - Not Auto-Repaired report. A care alert is 
generated for all items that were unable to be corrected. 

5 Review the affected charts and create a new append document with the item 
that should have been signed.

6 Remove the care alert for that item. The next time the repair script runs, it will 
detect that the item was addressed and it will no longer appear on the Unsigned 

The nightly job is set to run at 7pm by default so that it completes before 
CQR uploads. The start time for this job can be configured as needed. 

The nightly script may add duplicate clinical list items to the chart if a 
provider had noticed an error and manually added the change the same 
day. If an item appears twice, it can be removed in a new clinical update. 

Depending on the size of your database and the date range you choose, 
this script may take a while to run. You should schedule a downtime to run 
the script to reduce the performance impact for your users.
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Clinical List Items - Auto-Repaired and Unsigned Clinical List Items - Not Auto-
Repaired reports.

7 If you then run the Summary by Year, Summary by Provider, and Detailed 
Patient Clinical List Items reports the numbers will decrease for the items that 
were automatically repaired, but the manually repaired items will still be counted.

Running the reports

1 Locate the reports under Chart Reports > Reports > MedicaLogic > Unsigned 
Clinical Lists.

2 Select the report you want to run and click Preview.

After a care alert is removed, the repair script will ignore it , and it will not 
appear on the report again.

Depending on the size of your database and the date range you choose, this 
script may take a while to run. You should schedule a downtime to run the 
script to reduce the performance impact for your users.
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3 Enter the selection criteria. 

See "Appendix A: Sample reports" on page 33 for a preview of what the reports will 
look like. 

Selection criteria for 
the summary reports

Selection criteria for 
the detailed report

Selection criteria for 
the Auto-Repaired and 
Not Auto-Repaired 
reports

If you have issues with margins not printing correctly, check your printer 
settings.
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Known issues

Internet Explorer 11 (IE11) is not supported in CPS 12.0.12
To avoid potential issues with Growth Charts, Dosage Calculators, and the InfoButton 
we recommend that you do not upgrade to IE11. Although IE 10 is no longer 
supported by Microsoft, we anticipate minimal risk if the following precautions are 
taken. 

1 Limit the use of Internet Explorer, from the workstation, to the application; do not 
access the Internet. If access from the workstation to the Internet is required, use 
a different browser, such as Firefox or Chrome. 

2 Ensure your anti-virus and other software are up-to-date and enabled on all 
workstations. 

3 Implement a proxy server that implements White and Black lists to filter Internet 
access from the workstation, in order to block unwanted sites while granting 
access to sites required by the application such as Patient Education and 
Advanced Problem Search. 

CPS 12.2 will support IE11.

Features for future functionality display in SP12
Patient Banner: In Setup| Settings > Chart > Patient Banner, the [Change] Patient 
Banner view for the default (factory) patient banner displays two MEL symbols related 
to future functionality: PATIENT.MEDICAREADVANTAGE and 
MEDICARE_ADVANTAGE_FEATURE. This content can be ignored or removed if you edit 
this banner.

Medication interactions cannot be overridden when using the 
Medication Administration HTML form
If a patient has an allergy on their Allergy List and a user opens the Medication 
Administration HTML form in the chart and adds a medication with an interaction to 
something on the patient’s Allergy List the interaction warning icon appears as soon 
as they enter the medication in the Select Medication field. 

The user clicks “Me”, “Today”, “Today”, then “Commit Request”, and then immediately 
clicks “Administer” to finish the workflow for administering the medication. The user 
then places the document On Hold with “Sign Clinical List Changes” checked or signs 
the document and the interaction override box appears, but the boxes are grayed out 
and cannot be selected. 

If the user unchecks “Sign Clinical List Changes” they can put the document on hold, 
but there is a Clinical List Lock on the document and no other clinical list changes can 
be made.

Workaround: If the user does the following after requesting the medication on the 
form, but before administering it they should not get the interaction:

1 Close the Medication Administration form.

2 Click Meds to add a new medication, click on the Reference List to search for the 
medication and highlight it , and then click OK.

3 Click the Interaction Warning icon, check the box to override the warning and 
choose a reason from the drop-down, and then click OK.

4 Put the document on hold with “Sign Clinical Lists” checked.
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5 Open the document and open the Medication Administration form continue to 
administer the medication.

Alternate workaround: Add the medication to the patient's medication list first, then 
open the Medication Administration HTML form to create the order and administer.

SPR 62813

Unable to use ICD-10 problem custom lists immediately after 
importing clinical kit
After importing a custom Problem list that includes both ICD-9 and ICD-10 codes, the 
list name can be seen but is not accessible in Problem Quick Search because it takes 
time to re-index search-related resources in the database. SQL Server Agent must also 
be running for automatic re-indexing for problem search and other automatic refresh 
features to work properly.

Wait at least 15-20 minutes after import before attempting to search in the custom 
list. Otherwise the system may crash, you’ll have to remove the list, and in some cases 
a JBoss restart will be required. SPR 62949

In some environments CPS Client cannot initialize when JBoss and 
multiple websites are installed on drive other than primary (C:) 
Install JBoss, Service Layer, and multiple websites on the Primary drive of JBoss target 
machine when using Server Configurator. SPR 64267

No onset date in Preload Problem Form results in wrong onset date in 
Edit Problem dialog
When adding problems using the Preload Problem form, if you do not enter an onset 
date for a selected problem, the date displays as <blank> in the Problem list after 
saving. If you edit the problem, the default onset date is “1/1/1960” instead of the 
current (today’s) date. This is caused by a problem with MEL_ADD_PROBLEM symbol 
that will be corrected in the GA release of this service pack.

Workaround: If you forget to enter an onset date, when you edit the problem correct 
the default date. SPR 59615

Intermittent errors when upgrading on Windows Server 2012
Occasionally, users on Windows Server 2012 may see the error: “Windows server 
2008 R2 is required and SQL server instance is NOT hosted on Windows server 2008 
R2. You must select a different SQL server instance.” There is no known workaround. 
SPR 60257

Before you install this release...
Before installing this release, please review the following checklist of system 
requirements, important pre-installation considerations, and steps to watch out for 
during the install to ensure a successful upgrade.

Supported upgrade paths
You can upgrade to this version from the following versions:

Re-indexing also happens after upgrade to this service pack. Wait at least 15-
20 minutes after upgrade before testing problem search features. 
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 Centricity Practice Solution v7.1.2, v8.10, v9.x, v10.1.x, v11.x and v12.0.x.

Compatible client versions
 Terminal services/Citrix server: Centricity Practice Solution v12.0.12 and 

Centricity EMR 9.8 client applications can be installed on the same server.

 Standalone client workstation: Centricity Practice Solution v12.0.12 and 
Centricity EMR 9.8 clients can be installed on the same workstation. 

Confirm system hardware and software requirements
Review all hardware and software requirements for your system and confirm your 
system meets minimum requirements.

See Configuring Environments for Centricity Practice Solution and the Calculating 
Hardware Requirements spreadsheet to fine-tune your hardware requirements. 

Latest versions of these documents are available on the Centricity Services Web site 
at https://engage.gehealthcare.com/community/en/cps/documentation.

Support for interface engines
Qvera Interface Engine (QIE) is the preferred transport mechanism for Meaningful Use 
2014 reporting. Qvera and GE offer and provide direct support for interfaces for all 
Meaningful Use messaging/reporting. Qvera and relevant interfaces are available 
directly from GE. Contact your sales representative for additional information.

If you are upgrading to this release and using an unsupported interface engine, 
contact Centricity Services for information about its compatibility with this release and 
for help transitioning your existing interfaces to Qvera.

Support for ePrescribing
On Service Pack 9 patch 1 or later, Centricity Advanced ePrescribing requires 
Surescripts (formerly Kryptiq) eScript Messenger 3.6.0 (eSM). 

See Surescripts Enterprise Services documentation for latest, detailed configuration 
requirements and instructions for eScript Messenger, Integrated Secure Messaging, 
Patient Portal, and Document Management.

Back up customized clinical content
Before upgrading or installing Centricity Practice Solution v12.0.12, verify that any 
clinical content you have customized (text files used by CCC and customized rpt files, 
located in the crwrpt folder on the client) have been exported and backed up. Factory 

!!! Install the Centricity EMR 9.8 client FIRST, then install the Centricity 
Practice Solution 12 (PM-only) client.

!!! Microsoft Windows XP and Vista are no longer supported for the client. 
Internet Explorer v9 requires Microsoft Windows v7 or later.

https://engage.gehealthcare.com/docs/DOC-8630
https://engage.gehealthcare.com/docs/DOC-8630
https://engage.gehealthcare.com/docs/DOC-8631
https://engage.gehealthcare.com/community/en/cps/documentation
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forms and reports and other clinical content will be overwritten. You can redeploy 
custom content to workstations after the update.

Configure SQL Server to run the client on the server
If you are running the client on the database server, you must also select (local) named 
pipes and TCP/IP protocol for remote connection when setting up SQL Server, 
otherwise you may see a named pipes error when you launch the application.

Read the instructions in this release note document
Even if you have applied previous Centricity Practice Solution releases, you should 
read and follow the step-by-step instructions in this document to ensure all critical 
installation steps are addressed.

Install the release
Centricity Practice Solution v12.0.12 is released with different upgrade/install options. 
Follow the appropriate instructions for your situation:

 Install the full build - If you are upgrading from a supported older version of CPS.

 Install the service pack build - If you are upgrading from CPS 12.x.

Install the full build

Detailed instructions for upgrading to Centricity Practice Solution v12.0.12 from 
supported earlier versions are provided in Upgrading to Centricity Practice Solution in 
your documentation library.

Download CCC Basic package from Service Portal
Starting with the Centricity Practice Solution v12.0.12 release, the CCC Basic 
installation package is delivered separately on the Centricity Services Portal Web 
site. Refer to the document 'CPS Clinical Content Preferred Content Configurations”, 
available on the portal, to determine which versions of various clinical content 
packages are suitable for your version of the software. 

Go to https://engage.gehealthcare.com/community/en/cps/clinical-content to 
download the updated version of CCC Basic and release notes prior to upgrading 
your database. Refer to the CCC Basic release notes for information on installing 
updated content.

Download the complete documentation from
engage.gehealthcare.com/community/en/cps/documentation.

!!! After installing the CPS v12.0.12 update, be sure to apply the latest 
Knowledgbase update and ICD and CPT codes package. SPR 60480

https://engage.gehealthcare.com/community/en/cps/documentation
https://engage.gehealthcare.com/docs/DOC-175577
https://engage.gehealthcare.com/community/en/cps/clinical-content
https://engage.gehealthcare.com/community/en/cps/clinical-content
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Upgrade instructions for FilesAnywhere downloads
For releases available via FilesAnywhere, the download and installation instructions 
have changed:

Install the service pack build

Back up the Centricity Practice Solution database

1 From the Windows Start menu, select Programs | Microsoft SQL Server 2008 | 
SQL Server Management Studio. Click Connect .

The Object Explorer window opens.

2 Expand SQL Server Agent . 

3 Under SQL Server Agent , click Jobs.

A list of jobs displays in the right pane.

4 Right-click on the backup job for your Centricity Practice Solution database.

Example: Backup Database - CPS.

5 Select Start Job at Step.

The Start Job window opens.

6 Click Start .

1 Back up your current staging directory.

2 Download the zip file and save it to your server's desktop.

3 Right-click on the zip file and make sure it is not blocked. Click Unblock if 
necessary.

4 Extract the zipped contents to the root of your staging directory (such as 
C:\CPS 12 Staging) on the server.

Important . Never extract files across the network.

5 If you are installing the service pack build: Copy the 
\CPS_12_Staging\SS\SS contents to \CPS_12_Staging\SS directory to update 
the DLLs and serversetup.exe

6 Run serversetup.exe and jump to “Install the service pack on a server” within 
the Upgrade Guide for step-by-step directions to complete the installation

If an upgrade from any version of CPS fails, upgrade to CPS v12.0 and then 
apply the latest service pack.

!!! As a precaution, always back up your staging directory and the Centricity 
Practice Solution database before you download and apply a release.

To expand SQL Server Agent , click the plus sign (+) next to it .
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You will receive confirmation of success or failure of the backup within this 
window.

7 Click Close.

8 Exit SQL Server Management Studio.

Download the release

1 Close the Centricity Practice Solution client on all computers.

2 On the server where Server Setup application is located, log in to Microsoft® 
Windows as the Administrator.

3 Launch Server Setup.

4 Select Download Available Updates and then click Next . 

The website installation window displays the Centricity Practice Solution websites 
you have installed.

5 Select the website you want to update, then click Next . 

The Download Available Updates window displays links to updates available for 
the selected website.

6 Do one of the following:

 To begin downloading the release, click the service pack link. 

 To return to the previous window, click Back. 

The Downloading Update window displays the product version number, download 
location, total file size, and download progress.

7 Do one of the following:

 When the download is successful, the Downloading Update window displays 
“Completed” as the status. Go to step 9.

 If the download was unsuccessful, the Downloading Update window displays 
“Download Failed. Operation Aborted” as the status. Go to step 11.

8 When the download is successful, click OK and then click Exit , then Finish.

Server Setup closes and re-opens. 

9 Click Exit to close Server Setup. 

Server Setup closes and you can restart it when you are ready to apply the 
update. 

10 Proceed to the next section.

11 If the download was unsuccessful, click OK, and then click Cancel to close the 
Downloading Update window. Do one of the following:

 Click Back to return to the previous Server Setup window.

The time to download varies depending on available network bandwidth. 
Slow progress does not mean that the program is not downloading. The 
installer window will reappear once the download is complete.
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 Click Exit to stop the download process.

Before installing the release on a server

Before applying the release, perform the following steps:

Stop the MIK service
If you are running Millbrook Integration Kit (MIK), complete these steps before you 
install the release on your server(s):

1 Start Server Setup.

2 Select Advanced Options, then click Next .

3 Select Millbrook Integration Kit Configuration, then click Next .

4 Select the server where MIK is installed.

5 Click Stop.

Back up MIK configurations
If you are running Millbrook Integration Kit (MIK), complete these steps before you 
install on your server(s). In addition to exporting registry keys (described below), open 
Server Setup > Advanced Setup Options > Millbrook Integration Kit Configuration 
and take screen shots of your current MIK configuration.

1 On the server where the MIK service runs, click Start and choose Run.

2 Type regedit and press Enter. 

3 Export the following keys to the Desktop as backup:

HKEY_LOCAL_MACHINE\SOFTWARE\wow6432Node\AHC
HKEY_LOCAL_MACHINE\SOFTWARE\wow6432Node\GE
HKEY_LOCAL_MACHINE\SOFTWARE\wow6432Node\GE Healthcare

4 Close regedit .

Stop the Data Transfer Station

1 Stop the Data Transfer Station.

2 Navigate to the Centricity Practice Solution/Client directory and copy the 
emr.ini file to your Desktop.

If multiple attempts to download fail, contact Centricity Practice Services 
at 888.436.8491 option 1 or your Value Added Reseller (VAR).

!!! Do not do this step on your own if you are unfamiliar with regedit . Get 
help from a qualified network/IT engineer.

If you are installing MIK on a 32-bit system, the keys are located in the 
folder HKEY_LOCAL_MACHINE\SOFTWARE\
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Optional: Shut down Qvera Interface Engine (QIE) 
Shutting down QIE before a service pack upgrade is not required or necessary but 
might be done optionally. If QIE interfaces configured on your system are listening on 
TCP/IP ports for incoming messages from other systems and feeding them into the 
LinkLogic inbound folders, they probably do not need to be stopped. If you have the 
Qvera TOC package installed, however, you might want to stop the TOC channels or 
shut down QIE while this upgrade is being completed. 

Refer to your QIE documentation for detailed instructions.

Install the release on a server

1 On the server Desktop, double-click the CPS 12 Launch icon. 

2 On the launcher Welcome screen, select Install/Update Server, and then click 
Server Setup. 

Server Setup opens.

3 In Server Setup, select Advanced Setup Options, and then click Next .

4 Select Upgrade, and then click Next . 

The System Configuration Completed window appears.

5 Click Next .

The Setup Directory Path and Log File Path window opens. 

6 Click Next . 

The Server Logon window opens. 

7 Enter your SQL Server administrative user name and password if necessary and 
click Next . 

Make sure the current server version is correct and the version to upgrade is 
correct.

8 Click Next . 

9 Server Setup displays a data validation screen. The screen shows whether any 
data errors were found in the database. 

If there are no data errors, click Next .

If there are data errors, 

a Click Report to view details about the error(s). 

b After correcting the listed errors, click Re-Run Validations to make sure there 
are no additional data errors.

c Click Next when data validation finds no errors.

The End User License Agreement window displays.

10 Accept the license agreement and click Next . 

The License Code window displays.

11 Click Next on the License Code window.

Double-check the server name at the top of the window. It should be the 
database server hostname.
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If you have purchased Crystal Reports integrated designer, you are prompted for 
the names of the workstations that utilize the Crystal Reports licenses. Review the 
information. Click Modify to enter the workstation names. 

12 Click OK.

If a database message window displays about users not found locally, read the 
message and click OK.

13 Click Next to begin the installation.

A window displays update progress. 

Note. You might see the following messages:

 If you see the message “You must apply latest ICD/CPT codes package before 
using the CPS Application.” click OK.

 If you see the message “There are custom stored procedures in the database 
that may need to be updated...” Click OK. Then check the Serversetup log for 
entries like this:
10/19/15 12:58:47 The following custom stored procedures
should be checked for validity:

CusAssignSpecialties
cus_SET_OBS_EXPORTED
cusFindAllPharmacies
cusGetPharmacyByID

In SQL Server Management Studio, re-execute each custom stored 
procedure. To view your custom stored procedures before upgrade, on the 
Prerequisite screen, click Report .

14 When the update is complete, the Return and Exit buttons display along with the 
message, “Your database upgrade has been completed. Press Return to return 
to the main menu.”

15 Click Return. 

The Choose Setup Option to Perform window displays.

16 Select the Server Configurator radio button to apply updates, install JBoss, 
Service Layer, and website. Click F1 to access the Server Configurator help for 
complete details. Server Configurator was initially released with Service Pack 10, 
and is used for JBoss and Service Layer installation. Refer to "Automated server 
configuration utility" on page 65 for an overview.

Here are the basic steps:

a Modify Connection Information must be selected to enable the controls.

b Enter your site information.

c Click Validate Database. If validation is successful, the number of Licensed 
Concurrent Users is displayed. If not successful, fix the displayed errors 
before continuing.

d Enter the number of Concurrent Users for your site. Selecting a number less 
than your actual number can result in insufficient resources. 

Optional: For planning purposes, you can enter up to 9999 users to calculate 
different configuration scenarios.

e Change the JBoss Port # if needed.
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f Once you know your configuration, click Add Server to add one or more 
servers. Specify the hostname (do not use localhost), and select the server 
role. Refer to the help for more information.

g Click Validate & Add. Correct any errors. When successful, the server is added 
to the grid.

h When all servers are present and validated in the grid, click Validate to check 
the entire configuration. Correct any errors and Validate again until all 
servers show successful validation status.

i Ensure all users are logged off for the duration of the installation.

j Click Validate & Install.

17 Setup security by going to Advanced Setup > Utilities > Security. Click Next on 
the Security window. If you are using AD security model, you must validate the 
security.

Install MIK

1 On the server where MIK is currently installed, navigate to the location of the MIK 
installer (default is C:\CPS_12_Staging\CPS_12_MIK) and run setup.exe As 
Administrator.

The following message appears:

This setup will perform an upgrade of CPS_12_MIK. Do you 
want to continue?

2 Click Yes.

InstallShield will open and step you through the upgrade. Select all the defaults 
until you see InstallShield Wizard Complete.

3 Click Finish.

4 Locate the AHC and GE Registry files you backed up earlier. Double-click the files 
to import to the Registry.

Install the release on workstations

If you licensed the PM module only, skip to "Install the release on workstations" on 
page 29.

If you licensed the Chart module and are using LinkLogic, update client 
workstations in the following order:

1 "Update Data Transfer Station" on page 27.

2 "Update LinkLogic on the server" on page 28.

!!! After installing the CPS v12.0.12 update, be sure to apply the latest ICD and 
CPT codes package. SPR 60480

!!! Only perform this procedure if you have the Millbrook Integration Kit (MIK). 
DO NOT uninstall MIK.
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3 Update all other client workstations. See "Install the release on workstations" on 
page 29.

Update Data Transfer Station

When you apply this release on a workstation, the files in the Client directory are 
overwritten, including the emr.ini file that contains your DTS configuration. 

Install the release on a DTS workstation

1 Start Centricity Practice Solution on a workstation.

The Product Installer page displays. 

2 Verify your URL points to the correctly updated webpage.

a Right click on the Centricity Practice Solution client desktop shortcut. 

b Select Properties > Web Document . 

c Copy and paste the URL if needed. 

3 Click the Update link (in red) for CPS_12_Client .

4 The Installer will detect that an older version of the client application exists and 
ask you to uninstall it .

5 Click Here to uninstall.

The removal process uninstalls the application.

!!! DO NOT update any client workstations until you have updated the Data 
Transfer Station (DTS) and updated LinkLogic.

Before beginning, back up your directories. If you have customized files 
in the LinkLogic Config\Standard directory, contact Centricity Practice 
Services at 888.436.8491 option 1 or your Value Added Reseller (VAR), 
before completing this section.

!!! Before you update the client on the DTS, you must back up the emr.ini file to 
preserve the current DTS configuration so you can continue processing data 
transfers for lab results, transcriptions, and other documents without 
interruption.

If you are installing on a Windows 7 or Windows 8 workstation, you must 
run the Internet Explorer application as an administrator.

The installer cannot detect pre-9.0 clients. If you think you might have 
these clients installed, go to Control Panel > Add/Remove Programs to 
select and remove manually.
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6 When the uninstall process is complete, click Here to continue to the Client Setup 
page.

7 Click Install to download the installer.

The installer window opens. 

8 Select the Install Data Transfer Station option, and then click Next .

9 Click Next on all subsequent screens to accept default settings.

10 When the installation is complete, click Here to return to the Install page and 
close the window to exit .

11 When the client update on the DTS workstation is complete, open the backup 
emr.ini file you created prior to the upgrade. Copy the <ComputerName>DTS # 
section from the backup file to the new emr.ini.

Example: 
[HOSTNAME DTS 1]

DBNAME_L3ID=1220

DTSDesc=DTS Workstation Description

If there are multiple or duplicate HOSTNAME entries, only copy the lines for the 
current DTS. 

12 Update LinkLogic (next section) before restarting the workstation.

Update LinkLogic on the server

If you are using LinkLogic and Data Transfer Station (DTS) to exchange patient 
demographic and clinical data with external systems such as labs and transcription 
services, take the following steps on the machine where DTS is running. This will 
ensure that the update is properly applied to the LinkLogic configuration.

1 Confirm Data Transfer station is not running on the workstation.

2 Navigate to the LinkLogic standard folder (usually C:\Program Files\Centricity 
Practice Solution 12\Client\llogic\config\).

3 Right-click on the standard directory, and then click Copy.

4 Navigate to the remote LinkLogic config directory on your database/web server 
(such as \\<server_name>\llogic\config).

5 Right-click in the config directory, and then click Paste.

6 When asked if you want to replace the standard folder, click Yes to All.

7 On the DTS, navigate to the LinkLogic upgrade folder (usually C:\Program 
Files\Centricity Practice Solution 12\Client\llogic\config\).

When you uninstall the client application, you do not see a progress 
indicator for the uninstall. This does not mean that the program is not 
responding or terminated, however. DO NOT attempt to end this process.

The time to download varies depending on available network bandwidth. 
Slow progress does not mean that the program is not downloading. The 
installer window will reopen when the download is complete.
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8 Right-click on the upgrade directory, and then click Copy.

9 Navigate to the remote LinkLogic config directory on your database/web server 
(such as \\<server_name>\llogic\config).

10 Right-click on the config directory, and then click Paste.

11 When asked if you want to replace the upgrade folder, click Yes to All.

12 Restart Data Transfer Station.

Install the release on workstations

1 Start Centricity Practice Solution on a workstation.

The Product Installer page displays. 

a Click Start > All Programs. The Programs menu displays.

b Right-click the Internet Explorer shortcut and click Run as Administrator.

c Type your user name and password in the User Account Control dialog and 
click Submit . The Internet Explorer application opens.

If you are an administrator, click Allow on the User Account Control dialog.

2 Verify your URL points to the correctly updated webpage.

d Right click on the Centricity Practice Solution client desktop shortcut. 

e Select Properties > Web Document . 

f Copy and paste the URL if needed. 

3 Click the Update link (in red) for CPS_12_Client .

The Installer will detect that an older version of the client application exists and 
ask you to uninstall it .

4 Click Here to uninstall.

When upgrading a client on the database/web server, you may be required 
to reboot the machine during the upgrade process.

!!! Important! 3rd-party integration requirements. Some 3rd Party applications 
may need to be reinstalled following this upgrade. Contact your providers to 
confirm support for integrations and any new configuration requirements.

EDI Plug-ins. Uninstall, reinstall, and reconfigure your EDI plug-ins after 
upgrading to Centricity Practice Solution v12.0.12. Refer to the documentation 
included with your EDI plug-ins for information on installation and 
configuration.

If you are installing on a Windows 7 or Windows 8 workstation, you must 
run the Internet Explorer application as an administrator.
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The removal process uninstalls the application.

5 When the uninstall process is complete, click Here to continue to the Client Setup 
page.

6 Click Install to download the installer.

The installer window opens. 

7 On the installer Welcome screen, click Next , and then click Next on all subsequent 
screens to accept default settings.

8 When the installation is complete, click Here to return to the Product Update page 
and close the window to exit.

9 Restart Centricity Practice Solution on the workstation.

Install latest Knowledgebase

Chart Only and Joint customers only: After upgrading to Centricity Practice Solution 
v12.0.x, download and install the latest Full Knowledgebase update and any 
incremental update. 

All Customers: The latest ICD and CPT codes should be downloaded and installed, if 
you have not already done so.

Use JBoss JMX Console

Disable or enable contraindications
Users are seeing too many drug contraindication results, specifically drug-problem, 
drug-age and drug-gender contraindications. These displays make it more difficult to 
see truly critical health alerts and cause alert fatigue. 

Functionality added in v12.0.4 lets users disable and enable drug-gender, drug-age, 
and drug-problem contraindication checks. Three flags let customers independently 

When you uninstall the client application, you do not see a progress 
indicator for the uninstall. This does not mean that the program is not 
responding or terminated, however. DO NOT attempt to end this process.

The time to download varies depending on available network bandwidth. 
Slow progress does not mean that the program is not downloading. The 
installer window will reopen when the download is complete.

!!! If you have not done so already, after updating the client, clear the 
Internet Explorer browser cache. This prevents old information from a 
previous version displaying on the main product window. when users 
launch the client for the first time.

If installing on Citrix, reboot the Citrix server after installation is complete.
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turn off and on drug-gender, drug-age, and drug-problem contraindication checking 
in the client on the JBoss JMX Console.

1 To access JMX console go to

https://<your_server-name>:9443/jmx-console

where your_server-name refers to your JBoss Application Server name.

2 Log in as user admin with password cpAdm1n. This is the default login. Use your 
own configured credentials if they are different.

3 Select the com.gehcit.cp.<deploy-id> link under Object Name Filter to display 
available JMX beans in the right pane.

4 Next, select the DrugInteractionService node (shown below).

You’ll see three types of contraindication checking alert that can be excluded 
(shown below): 
DrugAgeCheckingEnabled
DrugGenderCheckingEnabled
DrugProblemCheckingEnabled 

5 Choose False for each type of contraindication checking alert you want to 
exclude, and then click on Apply Changes. (Default setting for all flags is True).

!!! This is a global configuration change that allows you to turn off any 
combination of Drug – Problem, Drug – Gender, or Drug – Age 
contraindications for your site. It does not affect how users see Drug - Drug or 
Drug - Allergy contraindications.

If the client application is open during flag changes, it must be restarted 
before the changes are reflected.
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This change is immediate and does not require a JBoss restart. All flag changes 
are logged to <DeployId>.CentricityPractice.log.

CPS v12.0.12 version information
Login to the client application and select Help > About to verify the build number.

 Client: 12.0.12.2500

 Server: 12.0.12.2500

 BMAC: Build 2042

 DataLink: Build 2029

 JBoss: Build 2615

 Service Layer: Build 2615

Access updates and services
To download additional services, Knowledgebase updates, or factory observation 
terms, go to the Centricity Practice Solution website at https://
engage.gehealthcare.com/community/en/cps. On the website, you’ll also find release 
publications, Support contact information, and links to training. To contact Support by 
phone,  contact Centricity Services at 888.436.8491 option 1, or your Value Added 
Reseller (VAR) Send email to centricitypmservices@ge.com.

Sign up for email announcements

To receive email announcements of new service packs, product alerts, maintenance 
reminders, tips and tricks, subscribe to the Centricity Practice Services mailing list. All 
GE customers can receive this free Listserve. 

To sign up, send email to centricitypmservices@ge.com. Include your name, your 
company name, address, and phone number in the body of the message.

https://engage.gehealthcare.com/community/en/cps
https://engage.gehealthcare.com/community/en/cps
mailto:centricitypmservices@ge.com
mailto:centricitypmservices@ge.com
mailto:centricitypmservices@ge.com
mailto:centricitypmservices@ge.com
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Appendix A: Sample reports

Unsigned Clinical Lists - Summary by Year
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Unsigned Clinical Lists - Summary by Provider
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Unsigned Clinical Lists - Detailed Patient Clinical List Items, CPS 11 version
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Unsigned Clinical Lists - Detailed Patient Clinical List Items, CPS 12 version
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Unsigned Clinical List Items - Not Auto-Repaired
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Unsigned Clinical List Items - Auto-Repaired
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What’s New since 12.0
This is a cumulative list of features, enhancements, important product notifications 
and fixes for each released Centricity Practice Solution 12.0 Service Pack. 

Click on this symbol to return to this summary page.

Fixed issues by service pack

11 - 10 - 9 - 8 - 7 - 6 - 5 - 4 - 3 - 2 Click to jump to the fixes. SP 1 was not released.

Important Product Notifications by service pack

Service Pack 11

 Pre-existing drug allergies cannot be overridden

 Users without override interaction permissions can acknowledge dosing 
warnings

 Special characters entered as values on flowsheet cause issues on Immunization 
History View

Service Pack 10

 Multiple users in a chart note at the same time results in data loss

Service Pack 6

 CPS 12.0.2 - A chart can be Merged even if multiple users have the source or 
destination chart open

 immun_getlist() is not showing immunization for Synagis CVX code 93

 Immunization migration missing factory obs to be migrated

 Immunization tool associating wrong vaccines with patients and not migrating all 
data 

 Incorrect HDIDs in geimmunizations spreadsheet

Service Pack 2

 The Immunization Migration tool can incorrectly set “was given” and 
“administered by” when importing

 DTS is forced to match on external ID after importing a fax status document from 
Biscom

 On the Review Electronic Prescriptions screen, the Authorizing Provider changes 
to the logged in user and the prescription cannot be sent.

New features and enhancements summary by service pack

Service Pack 11

 Patient Portal data masking - added the ability to mask patient data from 
displaying on your patient portal in the ambulatory summary CCDA-AS

 Transition of Care - shortened and easier for providers to review and customize

 Export ICD-9 or ICD-10 problem code or both in HL7 messages

 Clinical users can capture NKA and NKDA separately
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Service Pack 10

 Problem search - enhanced usability with ICD-10 specificity support

 Orders module - enhanced usability and ICD-10 specificity support

 Problem list cleanup

 Cloud-based advanced specificity problem search with clinical attributes options

 Build and manage Task queues with Diagnoses as a criteria

 Interoperability - MIK

 Other usability enhancements

 New forms added to CCC Basic v1.2

 ICD-10 planning and preparation resources on the Service Portal

 ICD-10 Preparedness Custom Reports (Service Portal)

 Automated server configuration utility

 Centricity Immunization Migration Wizard v1.51 available

Service Pack 8

 Updated New Medication window

 Prescriber History Report

 Changes to Electronic Prescriptions settings

Service Pack 7

 Support for 14 additional Clinical Quality Measures

 PQRS updates to capture Medicare FFS (Part B) patient visits

 MU 2014 Functional Measure changes (“MU SQL Patch”)

Service Pack 4

 Disable or enable contraindications

 Enable CCDA validation

 Modify CQR channels in QIE

Service Pack 11: New features and enhancements

Patient Portal data masking 
This release provides the ability to mask patient data from displaying on your patient 
portal in the ambulatory summary CCDA-AS, including lab results, problems, 
medications and procedures (orders). This feature is consistent with the requirements 
for meeting Meaningful Use View/Download/Transmit objectives. 

You can mask data that is confidential or sensitive, data that is required by state law 
or more appropriate to be communicated to a patient in person, or any data that 
might need to be masked for the safety and well-being of patients. When 
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implemented, this enterprise-wide solution automatically excludes or includes data 
you have configured whenever a CCDA is triggered to be sent to the patient portal. 

Implementing data masking - overview
To trigger data masking, you’ll do the following:

1 Create a custom list for problems, medications, and procedures and a flowsheet 
for lab results, with the following names required to trigger data masking:

Data Masking for Problems
Portal Data Masking for Meds
Portal Data Masking for Procs
Portal Data Inclusion for Obs [flowsheet]

Until these items are present in the database, all patient information is sent.

2 Add the values you want to exclude to the problem, medication, and procedures 
custom lists and add observations to include in the observation flowsheet.

Data masking for problems, medications, and orders
Data masking for these clinical list items is accomplished using custom lists that 
prevent data from being sent to the portal when a problem, medication, or order in the 
custom list is added to a patient’s chart. 

This solution does not affect the Clinical Visit Summary or Transition of Care 
CCDAs you create and customize within the application. It does not affect 
patient CCDAs sent to CQR for quality reporting analysis.

It will affect CCDA-AS you send to an HIE or to other systems using Qvera 
interfaces for sending CCDA-AS. If you support an integration where patient 
portal data masking preferences should be bypassed, please contact GE 
Support if GE is your reseller or Qvera Support if you purchased direct.

Optionally, import redaction.ckt , a clinical kit containing these items with 
a small set of sample clinical values. You’ll find this optional clinical kit 
posted on the Centricity Services Portal Download page at https://
engage.gehealthcare.com/community/en/cps/downloads. 

Important . The values included in the optional factory custom lists and 
flowsheet are sample values that might be excluded/included. You must 
update the custom lists and flowsheet with the values you want.

Data masking begins automatically at the enterprise level when these 
named items are created; values in the lists are excluded and only values 
present in the flowsheet are included. To delay this until your lists are 
complete, build them in your test environment and import to production 
when you are ready. Or simply build each list with a different name and 
then change it to the required name when you are ready. 

https://engage.gehealthcare.com/community/en/cps/downloads
https://engage.gehealthcare.com/community/en/cps/downloads
https://engage.gehealthcare.com/community/en/cps/downloads
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 Portal Data Masking for Problems - The optional factory starter kit contains a 
small set of problems likely to be masked. Edit this list of sample problems to add 
or remove problems you want to exclude. 

 Portal Data Masking for Meds -The optional factory starter kit contains a small 
set of medications likely to be masked. Edit this list of sample medications to add 
or remove medications you want to exclude.

 Portal Data Masking for Procs - The optional factory starter kit contains a small 
set of procedures orders likely to be masked. Edit this list of sample procedures to 
add or remove orders you want to exclude.
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Data masking for observations included in lab results 
Data masking for observations is accomplished using the flowsheet view Portal Data 
Inclusion for Obs. This is an inclusion list because the number of observations you’ll 
want to send is likely much smaller than the total list of factory observation values 
(3000+). You’ll want to also add your custom observations.

Only values on this flowsheet will be sent when they are saved to the chart. Edit this 
view to add all values you want to display on the portal. 

Transition of Care document enhancements
In this release, the Transition of Care (TOC) CCDA has been shortened and is easier for 
providers to review and customize. 

 TOC document is now encounter-specific, except where CMS requires 
otherwise, such as all active medications and problems. 

 All chart sections with data that was updated in the encounter are included in 
the TOC document and the provider can choose to remove sections that are not 
relevant for the transition of care.

If you create your own flowsheet, save it to the root of the Enterprise folder to 
ensure the system can access it .

To start with a larger list and remove selected observations, do the following:

1 In Administration, go to Chart > Flowsheet Views and then open the 
Enterprise > Interfaces > CCD folder. 

2 Select the Diagnostic Results view and click Copy.

3 Name the new view to Portal Data Inclusion for Obs or to a temporary 
name for building, and then rename when you are ready. All observations 
will be sent until you create a flowsheet with this name with only the terms 
you want.

Important . This new view must be at the root of the Enterprise folder with 
the name Portal Data Inclusion for Obs.
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Create a Transition of Care Document in the Orders module by right-clicking on 
an order. On the Preview screen, you can remove an entire section or customize 
its content. 

 Sections added for customization: Review of Systems, Physical Exam, Advanced 
Directives, Family History, History of Past Illness. These sections are included 
because they might include information relevant to the transition of care. 
Providers can customize the document to exclude these sections if appropriate.

 Displayed data is Visit Specific, Date Based, or Most Recent . While some 
sections require display of All Active data (problems, medications), most data are 
included that were added in the visit. The latest lab results observations are sent, 
including historical observation data.

Certain other recent data prior to the clinical date of the parent document might 
be included if the provider chooses to include them. For example, when social 
history, family history, advanced directives, and functional status assessments 
are checked for inclusion, if there is no relevant data from the current visit then 
data entered in a previous encounter will be included.

Export ICD-9 or ICD-10 problem code or both in HL7 messages
New LinkLogic export diagnosis code constraints for problems, procedures, and 
orders replace previous single option to export diagnoses with only ICD-9 codes. 

Under Export diagnosis code settings, you can now choose from the following options:

To configure settings, in Administration, go to System > LinkLogic > Task 
Options > Export Tasks and then select the appropriate export task.

Select one of these sections 
to view individual items to 
exclude. Check/uncheck 
displayed items to include. 

Uncheck a section to 
remove all its content. The 
section heading appears in 
the document with a note 
that content is not 
available. 
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 Export diagnoses with 2 codes - sends ICD-10 and ICD-9 codes if both are 
available. Sends ICD-10 code and SNOMED code if no ICD-9 code is available. 
(Default setting for new installations)

 Export diagnoses with only ICD-9 codes - sends only the ICD-9 code for each 
diagnosis.

 Export diagnoses with only ICD-10 codes - sends only the ICD-10 code for each 
diagnosis. SPR 63757

Clinical users can capture NKA and NKDA separately
Chart users can now capture No Known Drug Allergies (NKDA) when an environmental 
or food allergy is present in the patient chart. When no allergies are documented, the 
No Known Allergies (NKA) check box is available. Once a food or environmental allergy 
is added, the No Known Drug Allergies (NKDA) check box is available. SPR 64053

Cloud-based Advanced Specificity Problem Search available
Cloud-based Advanced Specificity Problem Search previously in limited availability 
for testing in SP10 is now available for all customers. In this release, search methods 
are enhanced to improve the specificity of results returned. 

When this feature is enabled in Administration (in Advanced Features), all providers 
(enterprise-wide) using Full Reference Search in Chart or users searching in Billing 
and Case Management will access the latest HLI ICD-9 and ICD-10 code database 
and can quickly find and select the most specific diagnosis code for billing.

 Advanced Specificity Problem Search has been modified so it returns precisely the 
result a user selects from the Advanced Specificity Problem Search window. SPR 
64113

 The Internet URL site type for Advanced Specificity Problem Search cannot be 
inadvertently changed in Administration and interrupt the connection. SPR 64140

On upgrade to SP11 from earlier versions your previously selected value 
will be retained. 

 If Export diagnoses with only ICD-9 codes was checked before 
upgrade, then on upgrade Export diagnoses with only ICD-9 codes is 
set. 

 If Export diagnoses with only ICD-9 codes was unchecked before 
upgrade, then Export diagnoses with 2 codes is set.
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Changes impacting Meaningful Use / Quality Measures reporting 

This section includes important information about fixes and enhancements impacting 
Meaningful Use Functional and Quality Measures reporting. in this release and in 
related Knowledgebase and Clinical Quality Reporting (CQR) web site updates.

Functional Measures fixes

Important. In most cases, the following fixes prevent a specified problem going 
forward. To correct issues in past patient records, you must manually reset and rerun 
your FM subscription for the reporting period before attestation. 

Contact GE Support or your supporting VAR organization to configure and resend 
your data.

Objective 5: Referral orders included in Summary of Care measure 
denominator 
Previously, when a user completed a Transition of Care referral order on the same day 
that it is signed, it was not sent to CQR even though it was marked as Transition of 
Care. In this release, a script finds these events and resends them to CQR for inclusion 
in the calculation. Affected measures include:

FNC_2_Core_15v2 Summary of Care Measure B
FNC_2_Core_15v1 Summary of Care
FNC_1_Menu_8v1 Transition of Care Summary

Important . To correct these omissions historically, you must manually reset and rerun 
your FM subscription for the reporting period. 

New Quality Reporting Community
Visit the new Quality Reporting Service Portal page regularly for new information, 
updated Quality Reporting guide and other documents, and webinars at https://
engage.gehealthcare.com/community/en/cps/quality-reporting-community.

Resending data for 2015 reporting period
Customers attesting for Meaningful Use or reporting for PQRS for a 2015 
reporting period will likely need to send revised data to CQR. 

Some changes noted below require resetting the Functional Measure and Clinical 
Quality Measure subscriptions to resend data for the current reporting period. 

Contact GE Support or your supporting VAR organization to configure and 
resend your data.

View the following Webinar to learn what data update steps must be completed 
for PQRS and Clinical Quality / Functional measure reporting before you send 
final data to the CQR web site.

On the Centricity Services Portal, go to the View Past Webinars page at 
https://engage.gehealthcare.com/community/en/cps/webinars

Under MU/PQRS Preparation Series, MU and PQRS select the Webinar 
“Choosing a Service Pack and data submission requirements”. View the section 
entitled “Data Subscription Reset”.

With the Modifications to Meaningful Use in 2015 Through 2017, the second 
and third measures are now obsolete.

https://engage.gehealthcare.com/community/en/cps/quality-reporting-community
https://engage.gehealthcare.com/community/en/cps/quality-reporting-community
https://engage.gehealthcare.com/community/en/cps/webinars
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If you use Centricity Clinical Messenger with Centricity Patient Portal, you must also 
upgrade to v6.4.15, available separately from GE or your VAR or from Surescripts. SPR 
64332

Objective 5: Summary of Care numerator and denominator match if 
order is changed after being signed
Under several workflow scenarios, when a Transition of are document was sent 
electronically, the numerator might be recorded using the wrong ID to link the 
numerator to the denominator, causing unmet measure results. In this release, a script 
finds these misattributed events and resends them to CQR Web site for inclusion in 
the calculation. 

This affects FNC_2_Core_15v2 Summary of Care Measure B. 

Important . To correct these errors historically, you must manually reset and rerun 
your FM subscription for the reporting period. 

If you use Centricity Clinical Messenger with Centricity Patient Portal, you must also 
upgrade to v6.4.15, available separately from GE or your VAR or from Surescripts. SPR 
64718

Objective 8: PATPORTALPIN correctly counted Electronic Access 
measures
A change in Service Pack 7 designed to add historical MUActivityLog entries for the 
PATPORTALPIN observation term used an incorrect parameter to determine whether 
to report patient access to the portal. As a result some patients' access was not 
counted toward Stage 1-2 Patient Electronic Access measures:

FNC_1_Core_11v1 Patient Electronic Access
FNC_2_Core_7v1 Patient Electronic Access

In this release, a script checks for these errors and automatically resends reporting 
data for affected patients and providers to the CQR Web site for inclusion in the 
calculation. Manual reset of FM subscription is not required. SPR 64741 

Objective 4: ePrescribing (eRx) patients provided medications with 
Samples Given method excluded from denominator 
According to CMS, only prescriptions written for drugs requiring a prescription to be 
dispensed should be included in the denominator. Samples given do not require a 
prescription. A patient who received a medication with the prescribing method of 
Samples Given is now excluded. Affected measures include:

Centricity Clinical Messenger / Centricity Patient Portal v6.4.15
Surescripts has made the following TOC-related changes in v6.4.15:

 TOC workflows and the SM-TOC encounter form now write the correct order 
ID to the MUActivityLog, increasing CQR numerator counts for measure 15. 

 When there is more than one order associated with an encounter document, 
the correct referral order information is identified by Surescripts, entered in 
the MUActivityLog, and sent to CQR. 

 All transition of care messages contain the required CCDA when Direct 
protocol is used. The workflow is compliant with CMS requirements and all 
messages are counted for Meaningful Use. SPR 64630

Contact GE, your Value-Added Reseller, or Surescripts for upgrade information. 
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FNC_1_Core_4v1
FNC_2_Core_2v1

Important . To correct these errors, you must manually reset and rerun your FM 
subscription for the reporting period. SPR 64839

Clinical Quality Measure fixes

In most cases, the following fixes prevent a specified problem going forward. To 
correct issues in past patient records, you must apply the September Full 
Knowledgebase update and manually reset and rerun your CQM subscription for the 
reporting period before attestation.

Contact GE Support or your supporting VAR organization to configure and resend 
your data.

CCDA failure for getAssessmentDataforProblem errors no longer 
occur
Previously, in larger databases occasionally some patient charts included problem 
assessments that were not linked to problem. The CCDA builder failed when it 
encountered these orphaned assessments, causing the CQR Dashboard to display the 
only the PID for a patient with no other demographic information. SPR 64706

CCDA sends Physical Exam section and includes BMI% observation 
value
Previously, a physical exam section was not imported into CQR. Exam sections for the 
following measures are now always sent. SPR 62743

 CMS 123 Diabetes Foot Exam

 CMS 131 Diabetes Eye Exam 

 CMS 155 Wt Assessment and Counseling for Nutrition and Physical Activity for 
Children and Adolescents - BMI% observation term is now included.

See also "CAMs not required for procedures, interventions, physical exam elements" 
on page 49.

CCDA builder exports procedures or interventions 
The CCDA builder now exports procedures and interventions recorded as observations 
that were previously not included. See also "CAMs not required for procedures, 
interventions, physical exam elements" on page 49. SPR 62850

Impacted measures include:

 CMS 22 Preventive Care and Screening: Screening for High Blood Pressure and 
Follow-Up Documented – exercise counseling sent.

 CMS 130 Colorectal Cancer Screening – risk factors form and colonoscopy result 
recorded as observation sent.

 CMS 68 Documentation of Current Medications in the Medical Record – Meds 
Reviewed observation sent.

 CMS 155 Wt Assessment and Counseling for Nutrition and Physical Activity for 
Children and Adolescents – counseling elements provided during a visit recorded 
as observations sent.

 CMS 169 Bipolar Disorder and Major Depression: Appraisal for Alcohol or 
Chemical Substance Use – “How much do you drink” results sent.
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Clinical list entries removed as Entered in Error excluded
CCDA builder now excludes clinical list entries (problem, medication, allergy, and so 
on) removed with reason Entered in Error so they are excluded from measures. This 
change impacts all CQMS. SPR 64230

CCDA physical exam section includes a coded result attribute
Observation values now have a mapped coded value type that will send a code for 
values like “positive” or “negative” previously recorded as text for CMS2 Preventive 
Care and Screening: Screening for Clinical Depression and Follow-Up Plan. CQM_MAP 
table has two new columns ResultCode and ResultCodeSet to store these values. SPR 
59756 

SNOMED diagnosis codes missing in SP 10 restored 
Problem Full Search now stores certain SNOMED codes needed for Quality Reporting 
when a CCDA is generated. The impact is limited to the following measures and to 
values used to exclude patients from the count for a measure: CMS 56, CMS 61, CMS 
64, CMS 66, CMS 90, CMS 117, CMS 132, CMS 135, CMS 140, CMS 144, CMS 145, CMS 
149, CMS 165. 

Important. This release corrects the problem going forward. Apply the September 
Knowledgebase update to address post-SP10 entries. SPR 64176, SPR 64275

Feature enhancements impacting reporting workflows

CAMs not required for procedures, interventions, physical exam 
elements
Prior to this release, using Conditional Action Metrics (CAMs) to add orders when an 
observation is recorded was the only way to add certain codes. The application now 
automatically sends codes for observations to CQR in the CCDA for codes in these 
QDM categories: Procedures and Intervention and Diagnostic Study. After installing 
this service pack, procedures such as Colonoscopy and Meds Reviewed do not 
require orders to be sent to CQR. You may disable CAMs for these data after the 
upgrade. See "CCDA builder exports procedures or interventions" on page 48.

In addition, the physical exam elements for foot exam and eye exam are included as 
observations with exam codes specified in the quality measures. See "CCDA sends 
Physical Exam section and includes BMI% observation value" on page 48. You may 
also disable CAMs for these after upgrade.

Data Mapping allows users to exclude values such as Patient 
Refused
Users can now map an observation to a code and exclude selected values such as 
“patient refused,” “medical reason,” and other unique values used by providers that 
should not be mapped. A new map type, NotExactCodeDescription, is added to the 
CQM_Map table to store excluded values.SPR 63708

To map observation values for exclusion, do the following:

1 Go to Administration, in Codes > Settings > Data Mappings and access the Data 
Search tab.

2 To view observation values used in your organization, enter a text string or code 
for an observation in the Search field and then check Include Observations and 
Include Values from Patient Records before searching. 
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3 In the list of returned values, when you select an observation term value mapped 
to a code, the Exclude Mapping button becomes available. 

4 Select a value that should not be mapped to the code and then click Exclude 
Mapping to exclude it. The code will be crossed out in the Mapped To column for 
the excluded value. (See screenshot below)

Important Knowledgebase updates

When upgrading to a service pack, you should always apply ALL the latest full and 
incremental Knowledgebase updates. 

This section includes information about specific Knowledgebase updates that work 
with this release to correct issues.

September Full Knowledgebase update
This update includes/supports: 

 Coded result attribute changes for CMS 2 Preventive Care and Screening: 
Screening for Clinical Depression and Follow-Up Plan. 

 2015 Value Set changes for Clinical Quality Measures.

 A script to correct SNOMED diagnosis codes documented after SP10 and 
impacting CMS 56, CMS 61, CMS 64, CMS 66, CMS 90, CMS 117, CMS 132, CMS 135, 
CMS 140, CMS 144, CMS 145, CMS 149, CMS 165. Note that after upgrade to SP11, 
all codes entered after upgrade will also be correct. SPR 64275

Other relevant changes

This section describes other important recent changes related to Clinical Quality and 
Functional measures. 

For full details, see the September Full Knowledgebase release notes 
available at https://engage.gehealthcare.com/community/en/cps/
downloads#knowledgebase. 

https://engage.gehealthcare.com/community/en/cps/downloads#knowledgebase              
https://engage.gehealthcare.com/community/en/cps/downloads#knowledgebase              
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See the latest posted version of the Quality Reporting Guide for all measure change 
details at https://engage.gehealthcare.com/community/en/cps/quality-reporting-
community.

CQR v1.5 (November 13, 2015)
Refer to the CQR 1.5 release notes for full details of this release, which includes these 
measure-related fixes:

 CMS 126 / NQF 0036 / PQRS 311 Use of Appropriate Medications for Asthma - 
All medications ordered and medications administered are treated as Medication, 
Dispensed in the numerator. 

 When a patient encounter uses a SNOMED code and another encounter uses a 
CPT code, they are counted as two episodes for the same visit for episode-based 
measures. Now CQR treats these two encounters as one episode if they meet 
these three criteria:

 Encounters are performed by the same provider.

 Encounters have the same start date.

 Encounters belong to the same value set.

This fix applies to these three episode-based measures.

 CMS68 / NQF 0419 / PQRS 130 Documentation of Current Medications in the 
Medical Record

 CMS146 / NQF 0002 / PQRS 66 Appropriate Testing for Children with 
Pharyngitis

 CMS154 / NQF 0069 / PQRS 65 Appropriate Treatment for Children with 
Upper Respiratory Infection (URI) 

CQR v1.4.5 (October 2, 2015)
The CQR v1.4.5 release supports these new measures:

 CMS 2 v4 (NQF 0419 / PQRS 134 / GPRO PREV-12) - Preventive Care and 
Screening: Screening for Clinical Depression and Follow-Up Plan - Requires SP11 
and September Full Knowledge Base update.

 CMS 64 v4 (PQRS 316) - Risk-Stratified Fasting LDL-C (for PQRS combined with 
61v4)

 CMS 66 v3 (PQRS 375) - Functional Status Assessment for Knee Replacement

 CMS 90 v 4 (PQRS 377) - Functional Status Assessment for Complex Chronic 
Conditions

 CMS 145 v4 (NQF 0070 / PQRS 7) - Coronary Artery Disease (CAD): Beta-Blocker 
Therapy – Prior Myocardial Infarction (MI) or Left Ventricular Systolic Dysfunction 
(LVEF < 40%)

 CMS 149 v4 (PQRS 281) - Dementia: Cognitive Assessment

 CMS 158 v3 (NQF 0608 / PQRS 369) - Pregnant Women that had HBsAg Testing

 CMS 169 v3 (/ NQF 0110 / PQRS 367) - Bipolar Disorder and Major Depression: 
Appraisal for Alcohol or Chemical Substance Use

CQR v1.4.5.1 (October 9, 2015)
 Functional Measure: Stage 1 and Stage 2 Medication Reconciliation - 

Previously, Medication Reconciliation was counted the first time a patient was 
seen by any provider in each provider's denominator. Medication Reconciliation is 
now counted in the denominator only for the first provider who sees the patient 
within the same clinic. If the patient sees two providers on the same day for the 

https://engage.gehealthcare.com/community/en/cps/quality-reporting-community
https://engage.gehealthcare.com/community/en/cps/quality-reporting-community
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first time, the Medication Reconciliation is counted in the denominator for both 
providers. (ALM 1493 and SPR 63836)

CQR v.1.4.4 (August 2015)
In the CQR v1.4.4 update, all 36 measures supported by CQR were modified to meet 
the July 2014 specifications, required for the 2015 reporting period. This is also 
reflected in the August Incremental Knowledgebase update noted above. 

Service Pack 11: Important Product Notifications

The following issues were resolved in this release:

Application allows users without override interaction permissions to 
acknowledge dosing warnings
Corrected a problem that allowed a user without the override interaction privilege to 
acknowledge the dosing warnings by clicking Override in the Drug Dosing suggestion 
window. SPR 63586

Special characters entered as values on flowsheet cause issues on 
Immunization History View 
Immunization Migration Wizard v1.51 released earlier this year automatically removes 
special characters that might cause problems. This corrected an issue causing 
Immunization History View to display MEL functions above Table when special 
characters were entered as values prior to running Immunization Migration Wizard. If 
you are running an earlier version consider upgrading to this version. SPR 62073

Service Pack 11: Fixed issues

The following issues were resolved in this release:

 Preferences - Administrator-set Schedule preferences for individual users now 
persist in the Administrator’s view after making changes for a user and logging 
out. Previously, Administrator’s changes were saved and visible to the user but 
not for the Administrator. SPR 53757

 Problem Search

 Quick Search using Smart List no longer displays problems marked as 
Inactive (non-billable). SPR 64471

 Advanced Specificity Search has been modified to return precisely the result 
a user selects from the Advanced Specificity Problem Search window. SPR 
64113

!!! Administrators and Risk Managers should review these Important Product 
Notifications for details concerning resolved critical product functionality 
issues.

!!! The behavior of the product has changed. Some users might be unable to 
dismiss a message they were previous able to dismiss and unable to sign the 
document as result. Other users might be prompted during an encounter for 
an interaction override reason where previously they were not required to give 
a reason.

Please check provider permission settings to confirm desired behavior and 
understand why this might be occurring.
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 Advanced Specificity Problem Search - Client no longer crashes when Advanced 
Specificity Search is enabled and user adds certain ICD-10 codes to the patient 
chart. SPR 64553

 Transition of Care (TOC) CCDA

 Checked/unchecked data items in Transition of Care “Customize Sections & 
Entries” sections are now properly included/excluded in the generated CCDA 
document. SPR 64509

 Restored the ability to see latest historical labs in the Lab Results section of 
the TOC CCDA per recently finalized 2015 Proposed Rules for Stage 2. SPR 
64655

 KB Update - Upgrade to SP11 after applying September KB update does not fail. A 
mismatch in the cqm_map.dsv file between the application and the September 
KB update has been corrected. SPR 64618

Administration
 Customize Letter Window in Administration now includes full view option. Click 

the maximize icon in the upper right corner to expand. Click again to minimize. 
SPR 63964

 The Internet URL site type for Advanced Specificity Search cannot be 
inadvertently changed in Administration and interrupt the connection. SPR 64140

Billing
 A user without appropriate permission is not prevented from using Batch Closing 

Override. SPR 60778

CCDA
 Corrected an issue causing CCDA validation errors when spaces are included in 

the Immunizations section Translation Code attribute value. SPR 59946

 CCDA now always includes the manufacturer Organization's 
standardIndustryClassCode. SPR 62374

Centricity Framework
 When running the Chart module in the Framework, Medication Override Reason 

list can now be accessed. SPR 64107

Chart
 Chart document view no longer randomly resizes to a smaller size. SPR 62420

 Corrected an issue where after an application error while documenting an office 
visit, pending observation terms were SIGNED at the moment of the error, even 
though the note remained unsigned. SPR 63017

 Patient Banner no longer disappears occasionally when the Enter key is pressed, 
for example, after discarding an open document or immediately after selecting a 
patient's chart. SPR 63923 

 Immunization Management form no longer crashes on Save when using the 
“Preload” encounter type. Previously, the form crashed if it was the only or first 
form listed in the document template associated with the encounter type. SPR 
63821

 TOC document now linked to master document directly instead of as a child of 
append. SPR 64158 

 Corrected issue that prevented users from double-clicking to open an on-hold 
Clinical Visit Summary. SPR 59408 
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 Application allows users without medication override privileges to acknowledge 
dosing warnings. SPR 64036

Common Event Model
 Corrected coding to prevent “Payload is not generated for the Job” errors in JMX 

Console when encountering certain null and empty values. SPR 63095

ICD-10
 Source Of Payments list on Insurance Carrier Information tab now displays the 

SOP Code before the Description to facilitate updates required for PQRS reporting. 
Previously only the Description displayed. SPR 64108

 Superbill report no longer prints ICD-10 code as ICD-9 code. SPR 62314 

 Problem Custom Lists now permit users to edit the ICD-10 code field. SPR 63941

 Find Problem workflow for some billable codes no longer returns an ICD-10 
diagnosis SNOMED code link that is a duplicate of the ICD-10 code when the 
SNOMED code should be null. SPR 64272 

LinkLogic / DTS 
 DTS Export Hereafter setting now works properly with multiple DTS and starts 

exporting changes from the hereafter time value as soon as it is set. SPR 61427

 LinkLogic now provides a way to send only an ICD-10 or ICD-9 code. For details, 
see "Export ICD-9 or ICD-10 problem code or both in HL7 messages" on page 44. 
SPR 63757 

Messaging implementations
 ChartLinx messaging now sends/receives data directly from chart to messaging. 

The messaging tab also correctly identifies when unsigned clinical list items are 
present. Previously, the Attach Chart window displayed a warning message for 
presence of unsigned clinical list items when there were no unsigned items on the 
patient chart. SPR 63978, 63982, 63823

Performance 
 Addressed a performance issue in archive_obs. Resolution also prevents 

archive_obs from being repeatedly exported by DTS. SPR 63363, SPR 62373

 Corrected a coding issue that caused exception in “CMainFrame::OnClose” when 
user clicked the X button multiple times on the application main menu page. SPR 
64152

 Application no longer crashes when the New Medication window is forced to 
close during an Idle Timeout. SPR 64122
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 Improved coding to enhance performance and reduce Chart open time. SPR 
64123

 Fixed an issue where Lastmodified and Lastmodifedby columns were not updating 
when making a change to a patient contact. SPR 63030

 Enhanced DocRoute (route lost documents job) to run more quickly. SPR 64144

Printers / Printing
 Printers specified for a service provider are now honored when tests and referrals 

are printed out during an update. SPR 63920

Problem Search
 Find Problem workflow for some billable codes no longer returns an ICD-10 

diagnosis SNOMED code link that is a duplicate of the ICD-10 code when the 
SNOMED code should be null. SPR 64272 

 Users can search for any keyword in quick search, using the *Smart List with a 
searchable entry in the Most Used Problem list . SPR 64142

 Problem Full Search now stores the SNOMED code needed for Meaningful Use 
when a CCDA is generated. SPR 64176

 The Internet URL site type for Advanced Specificity Search cannot be 
inadvertently changed in Setup and interrupt the connection. SPR 64140

Service Pack 10: New features and enhancements

Problem search - enhanced usability with ICD-10 specificity support
This release provides enhanced problem content and search capability / usability. It 
includes enhanced synonym support for Smart List searching, more accurate and 
complete mappings, simplified search workflows, and the ability to identify and 
quickly select the most specific (billable) codes.

These changes address a variety of reported issues related to incorrect mappings and 
descriptions returned in search for ICD-9 and ICD10 codes. SPR 53769, SPR 53822, SPR 
53823, SPR 54143, SPR 54975, SPR 59334, SPR 56429, SPR 59456, SPR 59579, SPR 
59615, SPR 59796, SPR 59796, SPR 60121, SPR 60123, SPR 60125, SPR 61405, SPR 
62002, SPR 62053, SPR 62142, SPR 62336, SPR 62238, SPR 62247, SPR 62259, SPR 
62260, SPR 62336, SPR 62338, SPR 62415, SPR 62509, SPR 62510, SPR 62805, SPR 
62930, SPR 63082, SPR 63173, SPR 62247, SPR 62930, SPR 63082, SPR 63173, SPR 
63347.

 Problem descriptions increased from 27k to 97k in the database for richer code 
set. 

 Search algorithm enhanced to increase precision and accuracy of the search.

A billable code contains enough specificity to be considered a valid diagnosis 
for billing. Factors such as clinical documentation, associated procedures, and 
individual payer requirements all affect the actual reimbursement of a specific 
diagnosis.
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 Quick Search Problem Search only displays codes that are specific enough for 
billing. Specific codes are defined as Active and with appropriate specificity (no 
child codes).

 Problem Custom Lists - Codes that are not specific enough for billing purposes 
do not display in problem lists. 

 Full Reference Search no longer displays the ICD-9 folder “drill down” 
hierarchy. Instead, the search displays group level codes and more specific codes 
depending on the search. Show Inactive Codes check box is also removed from 
the search window. 

 Full Reference Search always searches both ICD-9 and ICD-10 codes and 
retrieves codes based on clinical concept, so it is no longer necessary to choose a 
code type before searching. SPR 54777

 Group codes or other codes not specific enough for billing display in italic in 
the results window and cannot be used. Double-click these codes to drill down 
to related codes with greater specificity that can be used. 

Once a provider selects a diagnosis three times, it’s added to their Smart 
List to speed up searching. Smart Lists are used in the Quick Search and 
Full Reference Problem Search features. 

Some codes added to a provider’s Smart List might be invalid, incorrectly 
mapped, or lacking specificity. Now, however, only codes that are specific 
enough for billing are returned in Smart List search.

Quick Search, Full Search, and Smart Search for Problems will not filter out 
codes that are outside the bounds of an Effective and Expiration date 
range specified in Administration > Edit Diagnosis.

You should review custom lists to remove/replace invalid codes with more 
specific codes and to assure accuracy in the mapped ICD-10 codes. See 
"Problem list cleanup" on page 58, for help identifying problem codes that 
should be updated.
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 Insufficiently specific codes cannot be added to the patient’s problem list . 
When you select a code that is not specific enough for billing, the OK button is 
disabled and a warning displays,.

Orders module - enhanced usability and ICD-10 specificity support
 Orders module - ICD-10 specificity indicator. When you select a diagnosis from 

the Orders Potential Diagnoses list, a code that is not sufficiently specific for ICD-
10 displays in orange with an asterisk like this example: * BRONCHITIS and should 
not be associated with the order. The system will display a warning but will not 
prevent you from associating the code with an order.

To see more information associated with the code description, hover over the 
code to see the ICD-9 and mapped ICD-10 code. You must select another 
diagnosis code from the list for the order, or click Edit and search for a more 

When an insufficiently 
specific code is selected, a 
warning displays.

Double-click the code to 
select from more specific 
codes.

OK button becomes available 
when a more specific code is 
selected.
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specific code (see below). This workflow preserves the history with the previous 
code. 

 Orders module - Edit a diagnosis for an order in the Orders module - To change 
a diagnosis in the Potential Diagnoses list, select it and then click Edit . Then 
search for and change the diagnosis on the Edit Problem window. 

Problem list cleanup
With the transition from ICD-9 to ICD-10, it is necessary to review existing active 
problem lists for patients because they were originally coded with ICD-9 concepts and 
more specificity might be required. Custom problem lists should also be reviewed for 
accuracy in mapped ICD-10 codes or redesigned altogether to accommodate new 
coding concepts. 

Existing problems in a patient chart may have codes that are not sufficiently specific 
for billing, so you can run Non-Billable Diagnosis in Patient Records (Crystal) report 
to identify such problem codes for patients with past or future appointments and 
gradually update charts with more specific codes.

Screenshot here
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Cloud-based advanced specificity problem search with clinical 
attributes options
Cloud-based Advanced Specificity Problem Search is available in limited release to 
select customers based on number of users. If this feature is enabled for your 
organization, when you use the Full Reference Search in Chart or in Billing and Case 
Management , you'll access the latest HLI ICD-9 and ICD-10 code database where you 
can quickly find and select the most specific diagnosis code for billing. This feature 
must be enabled by GE Support.

 Enable cloud-based problem search - If enabled for your organization, in 
Administration, go to Advanced Features and check Enable Advanced 
Specificity Problem Search. 

 If your site loses Internet access, return to setup and uncheck this option to switch 
to the on-premise version of problem search. 

 Search for and select the most specific code using Clinical Attributes - From 
search results, select a term to review its level of specificity for ICD-10 billing. 
Where relevant, select additional Clinical Attributes for a more specific code, such 

Additional ICD-10 planning and preparation and problem list clean up 
resources are available on the Services Portal ICD-10 Web page. For details, 
see "ICD-10 planning and preparation resources on the Service Portal" on 
page 62.

Confirm your firewall permits workstation access to this URL: 
https://ge1.healthlanguage.com/le-services-342/soap/query
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as disease process, anatomical site, causative agent, episode of care, laterality, 
stage, healing, time course, fracture type, and so on. 

As you select attributes, icons indicate the level of specificity.

Build and manage Task queues with Diagnoses as a criteria
In Task Management > Queue Administration > Build Queues, the Queue Criteria 
pane allows users to search for and add one or more diagnoses to associate with the 
visit using the Find Diagnosis window. The application also alerts you when you have 
entered an invalid code.

Add screenshot here

Select additional attributes 
to increase specificity.
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Interoperability - MIK 
MIK can determine the correct ICD code when duplicate code names exist in ICD 9 
and ICD 10. When problem codes are received from an external system without a 
coding system name value, sometimes a unique match cannot be found based on the 
code value alone if the code value exists in both ICD9 and ICD10 code databases. 
When this happens, MIK sends “???” for the code to the Notes tab and notes that “MIK 
import found multiple codes matching the diagnosis ….”. To prevent these unmatched 
codes, MIK now matches using both the code value and the code system name. The 
coding system database to search is set to ICD9 by default in MIK Destination setup. 

Important. When your organization implements ICD10, change this setting to ICD10. 
SPR 63443

Other usability enhancements
Launch Update Medications, Problems, and Orders windows from Chart Update 
viewer. Buttons have been added to the Update Chart window to open Update 
Medications, Update Problems, and Update Orders. SPR 63076

New forms added to CCC Basic v1.2
 Patient Education Form: Added new demo form which recommends handouts 

based on the patients problems, medication and age. The user edit file CCCQE-
User-Edit-Patient-Education.txt located in the CCC folder of the package contains 
information on how to customize and use this form.

 Patient Education-WCC: New form helps provide appropriate handouts based on 
the patient's age. Designed for pediatric specialty. The user edit file CCCQE-User-
Edit-Patient-Education.txt located in the CCC folder of the package contains 
information on how to customize and use this form.

MIK searches and 
matches to ICD9code 
type by default. 

Switch option when 
you implement ICD10.



CPS v12.0.12 Release Notes

62

 Referral Loop-CCC: Can be used to review consultation reports. The form 
generates orders for the visit with appropriate SNOMED codes. Click “About” while 
in the form for full instructions.

ICD-10 planning and preparation resources on the Service Portal
 ICD-10 portal community - Go to this area on the Service Portal for ICD-10 

planning and preparation tools, active discussion forum, Webinars, and other 
external resources. Go to the main portal page for your product and then under 
Communities select the ICD-10 link.

https://engage.gehealthcare.com/community/en/cps

 ICD-10 Webinar series - numerous webinars presented over the past year 
provide detailed start-to-finish guidance for every aspect of your ICD-10 
implementation. Find slides in PDF format and webinar Webex recordings on the 
ICD-10 community site under View Past Webinars.

 Referral sources to outside vendors offering coding training, auditing at: 
https://engage.gehealthcare.com/community/en/cps/cps-icd-10/
content?filterID=contentstatus[published]~category[referral-services.

 ICD-10 tools - see Webinar and Site Roadmap for details. Resources include:

 ICD-10 Readiness Assessment - step through requirements for ICD-10

 ICD-10 Project Plan - spreadsheet project planning tool

 ICD-10 Preload EMR Clinical Kit - Review active problem lists in prep for the 
transition & flag reviewed charts as ready

 Crystal Reports for PM ICD-10 Prep - Top carriers by charges & visits, Top 
procedures by charges & visits, and top 100 diagnosis codes

 PM-Only Setup & Workflow Guide - A companion to the PM setup and 
workflow webinars

 Problems CCC Editor - Use this tool to assist in revamping your problems list

 Provider Audit Guide - Audit documentation through claims payment to 
identify areas of improvement

 Specialty Specific Coding - learn more about how to plan by specialty

ICD-10 Preparedness Custom Reports (Service Portal)
The following new Crystal Reports are available in a package on the Service Portal 
ICD-10 Web page. Additional report details and instructions for installing and using 
the reports is included with the package. 

The first two reports listed below can be used if you are running the joint (EMR and PM) 
version of Centricity Practice Solution. The remaining reports can be used by PM-only 
or joint customers,

 Billed ICD-9 Problems linked to Orders with Mappings - This report runs against 
orders within the Chart module and lists problem descriptions previously 
associated to orders, the associated ICD-9 and ICD-10 codes linked to the patient 
problem, and the GEMS Mapped ICD-9 Related Diagnosis that would pull from the 
claim if the ICD-10 code were to be sent into billing after the IDC-10 Enterprise 
Date. If your practice is on the joint product and flipping the switch prior to 
October 1, 2015, this report will help you understand whether current problems 
will map from the ICD-10 code to the originally selected ICD-9 for billing purposes. 

https://engage.gehealthcare.com/community/en/cps
https://engage.gehealthcare.com/community/en/cps/cps-icd-10/content?filterID=contentstatus[published]~category[referral-services
https://engage.gehealthcare.com/community/en/cps/cps-icd-10/content?filterID=contentstatus[published]~category[referral-services
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To identify any variations, use Billed ICD-9 Prob Orders with Mapping Variations 
report described below.

 Billed ICD-9 Prob Orders with Mapping Variations - Like the previous report, this 
report runs against orders within the Chart module and returns the same types of 
information only for problems where the ICD-9 code does not match the GEMS 
mapped ICD-9 code linked to the diagnosis. If your practice is on the joint product 
and is flipping the switch prior to October 1, 2015, it will help you understand 
which current patient problems if used as ICD-10 codes do not map back to the 
originally selected ICD-9 for billing purposes.

 GEMS Diagnosis Mapping Variations Report - This report returns results only if a 
user has edited preloaded GEMS mapped Diagnosis codes from the original GEMS 
mappings. 

 Reset GEMS Diagnosis Mapping Variations Active Report - This report contains 
the same information as the GEMS Mapping Variation report. It only returns 
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results when the ICD-10 Diagnosis mappings have been edited. As with any active 
report, this will update data within the database and should only be used if you 
are confident your mappings should be reset to CMS GEMS mappings.

 Insurance Carrier List by Payer Date Report - This report identifies your 
insurance carrier ICD-10 Payer Readiness dates and any carriers that may not be 
set to an appropriate ICD-10 Ready date. You can filter by ICD-10 Payer 
Readiness Date, Insurance Carrier, Insurance Group, and the ability to Include 
inactive carriers. 

 Appointments with Balance & BillCode Report - This report allows staff to 
prepare to ask patients for copay amounts and prior balances for the days 
appointments. It contains appointments for specified criteria such as resource, 
facility, appointment from, and appointment to dates. It displays patients 
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appointment times, patient name, billcode, budget amount, allocation set, patient 
balance, guarantor balance, and guarantor deposits.

 Appointments with Balance BillCode and Same Day Payment Report - Like the 
previous report, this report contains appointments for specified criteria. It 
provides a way to monitor how much of your patient share is being collected the 
same day as the appointment, so you can track when payments are not collected 
on the same day.

Automated server configuration utility
The Server Configurator calculates, installs and deploys the recommended JBoss 
and Service Layer configuration for your site. You can add/remove servers to meet the 
recommended configuration, validate, and then automatically install JBoss to support 
the selected configuration.

The Apply Updates, Install JBoss, Install Service Layer, Install Website, and Change 
App Logon buttons have been removed from Server Setup. You must use Server 
Configurator for these tasks.

Server Configurator is launched after you have installed or updated your database 
with Server Setup. The Server Configurator button is located on the main Server Setup 
menu. 

Press F1 after launching Server Configurator to access the online help.

Prerequisites
 Run this utility logged in with a domain account within the administrator group on 

all the servers. The servers should be on the same domain.

 Confirm or create an inbound rule on the database server for the firewall to allow 
the appropriate port to communicate with the database:

Centricity Practice Solution on SQL Server: Port 1433

 Confirm all servers have static IP addresses.

 Confirm the Windows Firewall service is running. The firewall can be turned off or 
on, but the service must be running (status=Started) for netsh commands to run.
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 Run this utility from your Centricity staging folder on a Windows based server. Do 
not run this utility remotely from a mapped drive.

 Verify target servers are running Windows Server 2012 or Windows Server 2008 
R2 Service Pack 1.

 Verify servers have at least 10 GB free disk space.

 Check the memory on your JBoss server. For servers with more than 64GB:

a RDP to the JBoss target deployment Server.

b Launch (right click) PowerShell ISE (Integrated Scripting Environment) and 
select Run ISE as Administrator.

c Run this script in the PowerShell window

d Verify there are no errors in the output window. If you see the following 
warning, restart the service.

WARNING: The updated configuration is effective only if it is less than or equal to 
the value of global quota WSMan:\localhost\Shell\MaxMemoryPerShellMB. Verify 
the value for the global quota using the PowerShell cmdlet "Get-Item 
WSMan:\localhost\Shell\MaxMemoryPerShellMB". WARNING: The configuration 
changes you made will only be effective after the WinRM service is restarted. To 
restart the WinRM service, run the following command: 'Restart-Service winrm'

 Open a Command Prompt as administrator, and run the WinRM quickconfig 
command on all JBoss servers without generating any errors. For example:

winrm qc

Refer to the Troubleshooting tab of the Server Configurator online help for other 
useful WinRM commands and possible errors.

 Install Microsoft .NET Framework 4.5. (dotNetFx45_Full_setup.exe).
Available here: http://go.microsoft.com/fwlink/?LinkID=242919

 PowerShell 3.0 or greater is required on each server in the configuration. You can 
determine the version of PowerShell on the system by executing the command 
$psversiontable in the PowerShell ISE window. PowerShell is part of the 
Windows Management Framework. If necessary, install PowerShell 3.0 
installation is included in the Centricity Staging folder. Navigate to: your staging 
folder\ServerConfigurator\Powershell 3.0 Installer and double-click Windows6.1-
KB2506143-x64.msu. 

 Ensure Windows Management Instrumentation Service (WMI) is running on the 
servers. For more information, see https://msdn.microsoft.com/en-us/library/
aa394582%28v=vs.85%29.aspx

 Enable Network Discovery and File and Printer Sharing for Windows Server 
2012 systems.

 Ensure Network Admin Shares are enabled for Windows Server 2008 R2 SP1. 
Enabled is the default. To verify network shares are enabled:

a Log in as local administrator on the JBoss server (for example 
JBoss_ServerName).

winrm set winrm/config/winrs '@{MaxMemoryPerShellMB="5120"}'
Get-Item WSMan:\localhost\Shell\MaxMemoryPerShellMB
Set-Item WSMan:\localhost\Plugin\Microsoft.PowerShell\Quotas\MaxMemoryPerShellMB 3072
Get-Item WSMan:\localhost\Plugin\Microsoft.PowerShell\Quotas\MaxMemoryPerShellMB
Restart-Service winrm

http://go.microsoft.com/fwlink/?LinkID=242919
https://msdn.microsoft.com/en-us/library/aa394582%28v=vs.85%29.aspx
https://msdn.microsoft.com/en-us/library/aa394582%28v=vs.85%29.aspx
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b Verify you can browse to the deployment drive (for example DeployDrive):

\\JBoss_ServerName\DeployDrive

If you are unable to browse to the network share, perform the Enable Network 
Admin Shares procedure.

Enable Network Admin Shares
These steps are only required on Windows Server 2008 R2 SP1 if Network Admin 
Shares are been disabled.

1 Click Start and then click Run. 

2 In the Open box, type regedit and click OK. 

3 Locate, and then click the following registry subkey: 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\LanmanServer\Parameters\AutoShareServer

4 On the Edit menu, click Modify. 

5 Enter 1 for Value data and click OK. 

6 Exit Registry Editor. 

7 Stop and then start Server service:

a Click Start , and then Run. 

b In the Open box, type cmd and click OK. 

c At the command prompt, type the following lines. Press Enter after each line: 
net stop server
net start server

d Type exit to close the Command Prompt window. 

The registry subkey AutoShareServer must be set as type REG_DWORD. 
When this value is set to 0 (zero), Windows does not automatically create 
administrative shares. Be aware that this does not apply to the IPC$ share 
or shares that you create manually.
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Basic workflow for Server Configurator
Here is the basic workflow for the Server Configurator.

Change password
The change password functionality has moved into the new Server Configurator tool. 
Before changing the password, stop the JBoss service on all existing machines in the 
current server configuration. Failure to do this may cause the SQL System 
Administrator account to be locked. The button appears in the middle of the dialog. 

Click Change Password and enter the following information:

 Database Server - enter the server name or SQL instance.

 Sys Admin User - enter the user to log into the database.

 Sys Admin Password - enter the password to log into the database.

 Database - select from the list of available databases.

 Application User - enter the application user name for the Service Layer.

1. Select Modify Connection Information

4. Calculate server configuration based on 
Concurrent Users.

2. Check if you are deploying multiple web sites. Select range from list.

5. Validate & Add servers and roles. When 
successful, server is added to Server Details.

6. Validate entire configuration. 7. Ensure all users are logged 
off and start final Validate & 
Install.

3. Enter site information and Validate Database.

The password is set during installation. It is not necessary to change the 
password as part of an upgrade. This procedure is only needed if you want to 
change the existing password.
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 New Application Password - enter the application password for the Service 
Layer.

 Confirm Application Password - reenter the application password for the Service 
Layer.

 Click Continue... and wait for confirmation that the password has been 
successfully changed.

Centricity Immunization Migration Wizard v1.51 available
This release includes the latest version of the Immunization Migration Wizard released 
earlier this year. The updated tool is located here:

<install path_staging_directory>DMImmunization\DMImmunization.exe. 

GE recommends re-running migration with the latest tool version
If you migrated data using an earlier version of the tool, GE recommends you re-run 
the migration to find and include partially recorded immunizations that were missed, 
clean up duplicates and Undetermined vaccines, and increase the accuracy of your 
records. Migrating again does not overwrite any previously migrated data or create 
duplicates. See Migrating and Managing Immunization Data for details. 

!!! Important! After changing the Application Password in the database, the new 
password must be set for the servers in the current configuration. 

 In the connection information area of Server Configurator enter the 
required information including new Application Password and re-Validate 
the Database.

 Upon successful Re-Validation, the Server Details for Installation grid will 
be populated with the current server configuration.

 Click Set Application Logon to set the new password to the servers in the 
configuration.

Important . DO NOT run this tool without first reviewing the release notes and 
associated user guide Migrating and Managing Immunization Data.

Download release notes and guide at 
https://engage.gehealthcare.com/community/en/cps/downloads 

https://engage.gehealthcare.com/community/en/cps/downloads 
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For information about how GE can help with your immunization migration process, 
contact inside.sales@med.ge.com. 

Service Pack 10: Important Product Notifications

The following issues were resolved in this release:

Multiple users in a chart note at the same time results in data loss
When two users are entering data into the same chart note, as the lock is transferred 
from one user to the other user, the data in the note does not refresh. For example, if 
one user puts the document on hold and the other user signs the document and saves 
their changes, the other user’s changes are lost. 

Resolution: When the lock is cleared the chart note for the active user is refreshed 
with the data entered by the previous user. SPR 63336

Service Pack 10: Fixed issues

The following issues were resolved in this release:

 Performance and stability enhancements. SPR 61049, SPR 61385, SPR 61797, SPR 
61923, SPR 63166, SPR 63333, SPR 63349, SPR 63374, SPR 63412, SPR 63434, SPR 
63438, SPR 63441, SPR 63466, SPR 63470, SPR 63474, SPR 63572, SPR 63655, SPR 
63816, SPR 63696

 Addresses various login issues. SPR 60959, SPR 60996, SPR 61011, SPR 61026, SPR 
61027, SPR 61028, SPR 61044

 Stability improvements during CCDA generation. SPR 56521

 Addresses an issue where the application would crash if the user tabbed out of 
the Prescribing Method field in the Refill Medication window. SPR 56999

 Addresses an issue where clicking to go to another form component from the CCC 
Basic encounter type opened a different component. SPR 58736

 Entering historical medications where the pharmacy’s prescribing method is 
electronic and the user does not change the prescribing method to Historical no 
longer prompts the user that a quantity is needed. SPR 59543

 Addresses an issue where users received a message about incomplete orders on 
every visit that had a test order that is not in a status of “Complete”. SPR 61402

 Updates to the Immunization Management HTML form to associate an allergy 
with an immunization adverse reaction. Users can now add, update, or remove an 
allergy (including criticality) to an immunization. The text translation has also been 
enhanced to translate criticality from an associated allergy and displays it in the 
chart note:

 New data symbols:

 MEL_ADD_ALLERGY_GET_GROUPID – Adds a new allergy or adverse 
reaction to the patient's allergy list and returns the reference 
(allergyGroupID) for an added allergy.

 MEL_GET_ACTIVE_ALLERGY – Returns the latest active allergy detail 
associated with a given allergyGroupID for a patient.

 MEL_GET_SDID() – Returns the current active document's SDID.

!!! Administrators and Risk Managers should review these Important Product 
Notifications for details concerning resolved critical product functionality 
issues.

mailto:inside.sales@med.ge.com
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 Updated data symbols:

 IMMUN_ADD, IMMUN_UPDATE, IMMUN_GETLIST – AllergyGroupId added 
to values returned for an immunization

SPR 61975

 Addresses an issue where the client crashed when putting an update on hold with 
a required field not filled in. SPR 62092

 Addresses an issue where entering two medications on the Medication 
Administration HTML form resulted in only the first text translation. SPR 62516

 Addresses an issue where bulk retrieving charges procedure codes were 
randomly duplicated multiple times for each charge on the visit. SPR 62595

 Addresses an issue where the scrollbar suddenly jumps to the top of the window 
during a refresh. SPR 62933

 Diagnosis codes are now saved correctly to the visit . SPR 62977

 Addresses various issues with formatting options in updates and letters not 
working correctly. SPR 57724, SPR 63069, SPR 63087

 Addresses an issue where the application crashed if the user clicked the close 
window (X) button multiple times. SPR 63164

 Addresses an issue where the application froze when adding problems from the 
orders window. SPR 63169

 Addresses an issue where CCDA generation caused an error in the Allergy section. 
SPR 63179

 Addresses an issue where, if LinkLogic is configured to create an on-hold 
document when appointments arrive, if an arrived appointment is then modified, 
a second on-hold document is created through DTS. SPR 63239

 Addresses an issue where the Transition of Care box was not staying checked if 
there were on hold documents. SPR 63262

 Corrects the data symbol ADD_ATTACHMENT() to restore the ability to specify a 
UNC moniker path for an image attachment starting with \\. Now a moniker can 
either be a relative path name or a UNC (absolute) path name, beginning with \\ or 
a URL, or something like “E://...” Backslash in the path names followed by special 
characters such as \t , \n, \r are also supported and properly interpreted. For 
example, “C:\radiology\tumor images\normal_mam.bmp”. See data symbols help 
for ADD_ATTACHMENT() for details and examples. SPR 63281

 Addresses an issue where the message “Error Occurred in Class, Method Window:: 
event - WMsg = 273” appeared and the application crashed when users opened 
various CCC Basic and Orthopedic forms. SPR 63372

 Only adjudicated procedures are considered to be included in the residual column 
once an ERA payment has been posted. SPR 63383 

 Adds diagnostic code to analyze the occurrence of 
“CurrentDomainOnUnhandledException” errors. SPR 63387

 Addresses certain situations that would cause the error “Error occurred in class , 
method CMLRouteDocumentDlg::OnSign”. SPR 63391

 Addresses an issue where clicking the New Document button caused the 
application to crash. SPR 63419

Important . This changes goes into effect when the July 2015 Centricity, 
Availity, and RelayHealth plug-ins are released and implemented. 
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 Addresses an issue where, if a user uses the refill button and the NDC Number has 
changed due to a Knowledgebase update, the new prescription failed due to an 
NDC number mismatch. SPR 63515

 Addresses an issue where users were asked to override interactions that were 
already overwritten. SPR 63520

 The document type is now included in the CCDA. SPR 63524

 Addresses an issue where one DTS appeared to be processing another DTS’ 
messages when there were multiple DTS instances. SPR 63530

 The prescription report for New Jersey now prints one medication per page. An 
additional report (prescnj_4up.rpt) is available if the requirement changes to allow 
multiple medications on a page. To use this report, rename the original prescnj.rpt 
file to any other name (for example, prescnj_1up.rpt) and rename prescnj_4up.rpt 
to prescnj.rpt. SPR 63560

 Addresses an issue where a patient’s date of birth falls in the current year, on 
initial load of CQR Subscription, the CCDA is not generated for that patient. SPR 
63598

 Addresses an issue where Functional Measure subscriptions were timing out 
while creating CCDAs, resulting in inaccurate CQR reports. SPR 63602

 Addresses an issue where DDIDs rolled over and were out of order, causing the 
application to crash. SPR 63629

 Addresses an issue where refilling a prescription from the chart caused the error 
“Refill is either 0 or the prescribing method is fax or electronic”. SPR 63211/SPR 
63670

 Addresses an issue where forms were not opening correctly when double-clicked 
in the navigation pane. SPR 63779

 Addresses an issue where the application crashed when appending a document 
with an embedded image. SPR 63884

 Addresses an issue where client crashed when a user closed a form and then 
logged out and logged in again as same user. SPR 63895

 Corrected issue on the Inquiries windows, where tabbing from the Find section 
caused client to crash. SPR 59262, SPR 56999

 CCDA now sends authorized by provider instead of signing provider for 
encounters and procedures so the patient is included for Clinical Quality 
Measures reporting. This corrects a problem where patient was not included in 
the CQM results even though a SNOMED code was appended to a qualifying office 
visit during the reporting period. SPR 63326

 Addresses an issue where an encounter form is hidden behind the chart module 
when a user logs out of the client during a chart update, and then logs back in as 
different user with “return to Chart”. SPR 63904

 Title bar for Confidential Encounter type now displays all relevant information 
instead of being blank. SPR 58142

 Addresses application error that occurs when attempting to approve a visit from 
the Visit window. SPR 63924

 Fixes an issue where the application crashes while a prescription printing is in 
progress, when the user selects a different form from the form list pane. SPR 
63851

Issues addressed for GA release:

 Quick and full problem search results that are an exact match for text entered 
now appear at the top of the list of returned results. SPR 63967
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 Corrected some keywords data content for problem search with incorrect 
associations. SPR 63808

 CPOE for Lab & Rad now calculating correctly in CQR if non-licensed staff enters 
the first in a series of orders for the patient. SPR 63686 

 In the Advanced Specificity Problem Search if a user selects a valid but less 
specific code with multiple refinement options, the search now returns the parent 
code. Previously, it returned the more specific first code from the refinement list, 
which could result in an incorrect problem being added to the patient's chart. SPR 
63999

 Advanced Specificity Problem Search attribute filtering now functioning properly 
and returning all appropriate codes. Previously, clinical concepts that require a 
circumstance code in addition to a primary diagnosis could not be refined to 
select the circumstance code. SPR 64002

 Addresses performance and stability issues occurring at sites running more than 
3 website/JBoss deployments. Now on Server Configurator you can choose 
configuration settings options for 2-4 or 5-8 web site deployments. See "ICD-10 
planning and preparation resources on the Service Portal" on page 62. SPR 63974

 Now when opening Chart from Schedule for the very first time, the Chart module 
is in from of the schedule and not minimized. SPR 63969

 Now when adding a form in a Full Append Update, the form is no longer 
occasionally hidden behind the chart window. SPR 63918

 The width of the desktop summary column now remains after it is adjusted. SPR 
53561/SPR 58368

 Fixes an issue where documents co-signed after the nightly JSON extract were 
not associated with the EP unless they were appended. SPR 63961

CCC Basic v1.2 includes the following fixes:

 You can now preload PCV7 in Immunization Administration. Vaccine 
Pneumococcal PCV13 is renamed to PneumoPCV in the Imm_vaccinegroupname 
table. SPR 64039

 The CPOE A&P-CCC Form now pulls in medications for all diagnosis codes. SPR 
61951 

 The Entry Form editor now opens the correct library file when “Open text file to 
edit” is clicked. SPR 63034

 Deleting a series in the middle of an immunization custom list no longer causes 
an error while loading the Immunization Management form. SPR 63444

 Fixed an issue where adding a problem in the CPOE A&P form resulted in an error 
during order generation. SPR 63315 

 Fixed an issue in the Immunization Management form where, if the Amount Given 
field contained both a numeric value and a unit dose, the vaccination record 
would not save. SPR 62141 

 The Problem- CCC form now correctly returns the mapped Problem Custom List. 
SPR 62202

 Fixed label in the Risk Factors-CCC form to read “Felt guilty about drinking:”. SPR 
62400

 ICD-10 codes now show in the CPOE A&P-CCC form in the Order Information 
message. SPR 62750

 The Entry-CCC form no longer adds MEL in the chart update. SPR 62866
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 In the Urgent Care Management form, the drop-down values can now be cleared 
under the Reasons Not Performed tab. Data no longer shows in the chart note 
after the values are irrelevant. SPR 62751

 The Add/Update dialog now allows users to edit the details if there was a 
validation error in the data entered. SPR 62845

 NDC and CVX are now added to the immunization translation to chart note. SPR 
63544

 Lot management fields are now cleared after deleting the lots. SPR 62836

 The correct Test Management form and editor are now included in the package. 
SPR 64033

Service Pack 9: Fixed issues

The following issues have been addressed in this release:

 Fixed an issue where provider names were not correctly displaying a suffix. SPR 
51010

 Inquiries can now be run to find patients based on Race Subcategory and 
Ethnicity Subcategory. SPR 62218

 An end date is no longer required when changing a Test Order. SPR 62535/SPR 
58666

 Fixed an issue where the default printer randomly changed. SPR 62575/SPR 
61077

 Fixed an issue where removed items on the medication list appeared in the wrong 
order. SPR 62578/SPR 62174

 Providers no longer get the error “The parameter is incorrect” when trying to sign 
a document while a prescription is pending with a prescription method of 
“Samples Given”. SPR 62618/SPR 60046

 Updated copyright information on the login window. SPR 62619/SPR 58409

 TOC documents can now be created when an order status is “In Process”. 

A change from “Admin Hold” to “In Process” status is a trigger for an automated 
TOC send and can have implications depending on your workflows:

a This change affects customers using the Orders Module to create Referral 
Orders that have a status of “In Process” when signed and are using an 
automated TOC CCDA generation process (QIE TOC).

A CCDA TOC automatically generates when a Referral Order is “In Process” 
and has a service provider with an electronic address. When an order like this 
is signed, the TOC generates and sends an un-customized TOC. When a 
Referral Coordinator returns to the Referral Order to customize, create, and 
send a TOC at a later time, a second TOC is generated and sent to the 
recipient provider. The recipient provider can expect to receive two different 
TOCs, whose difference depends on the amount of customization, at two 
different times, depending on the duration between original signing and TOC/
referral coordination. 

It does not affect the MANUAL Surescripts Secure Message workflow.

b This change affects all customers; GE's definition of “In Process” is changed. 
Previously, “In Process” meant that all referral coordination was completed, 
and the order was sent. Now it means the CCDA can still be generated and 
modified. This may cause some confusion to users that are used to how the 
orders module works.



What’s New since 12.0

75

SPR 61535/SPR 62646

 The Immunization HTML form now records clinical list changes for historical 
vaccines. SPR 62647/SPR 61973

 Providers no longer get the error “An Authorizing Provider is Missing for Order” 
when ordering more than one SPR 62649/SPR 56446

 Improved application stability when a network or server error is encountered. SPR 
62694/SPR 61410

 TOC and CVS documents now print fully when it was previously saved in the chart. 
SPR 62724/SPR 59084

 Signing a received lab result no longer causes the auto-completion of orders to 
regenerate CCDA documents. SPR 62747/SPR 62714

 Fixed an issue where an “Undefined” message appeared on certain medications. 
SPR 62763/SPR 62224

 Assessments are now included in the CCDA as structured data. SPR 62774/SPR 
62822

 CCDA GE General Observation section now includes all observation data. SPR 
62775/SPR 62825

 CCDA documents now include tracer IDs. SPR 62776/SPR 62816

 Document types “Clinical Visit Summary”, “History and Physical Note - Imp”, 
“Progress Note - Exp” and “Progress Note - Imp” have been removed from the 
Document Type drop-down list in the Update Chart dialog. SPR 62793/SPR 58047

 Fixed an issue where patients were randomly left off a statement run when 
batching them from Reports > File > Statements. SPR 62849/SPR 61659

Service Pack 8: New features and enhancements

Updated New Medication window
A route can now be selected when defining the medication to be prescribed. By 
default , the route information from Medispan is automatically entered, but an 
alternative route may be selected from the drop-down. If route information is not 
available from Medispan, this field is blank and can be manually selected. For existing 
medications, the route information is blank. Users may update the route information 
in the Change Medication window. The updated route will not appear in MEL symbols 
or CCDA documents. SPR 62121

Prescriber History Report
A new audit report has been added that retrieves the list of prescribed medications for 
a specific date range and user. SPR 62347

Changes to Electronic Prescriptions settings
The Electronic Prescriptions settings have been updated to allow for more granularity 
when specifying methods for sending prescriptions via fax or electronically. Previously, 
enabling/disabling electronic prescribing and direct faxing of prescriptions to a 
pharmacy were combined. To better support practices in States that allow electronic 
prescribing, but disallow direct faxing of prescriptions, these selections have been 
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separated. Please consult your State law and configure appropriately. Access the 
settings via Administration > Charts > Electronic Prescriptions. SPR 62080

The settings for electronic prescribing of controlled substances now include:

 Allow Electronic Prescribing For Medications In Controlled Substance Schedule 2

 Allow Electronic Prescribing For Medications In Controlled Substance Schedules 3 
Through 5

The settings for faxing prescriptions now include:

 Allow Faxing For Legend Medications

 Allow Faxing For Medications In Controlled Substance Schedules 3 Through 5

Service Pack 8: Fixed issues

The following issues have been addressed in this release:

 Fixed meaningful use calculations for the NQF 0028 and CPOE Qualification 
reports. SPR 48663, SPR 48670

 Problems that were Filed in Error no longer appear on the Clinical Visit Summary 
or CCDA. SPR 61225/61201

 Redesigned CVS layout so that it is easier to read. The header (patient information) 
is clearly separated from the rest of the CVS sections and content. SPR 61416/
61181

 Generic or uncoded medications that were administered now appear on the CVS 
and TOC. SPR 61418/61242

 Only Immunizations administered during the current visit are included on the CVS 
and TOC. SPR 61420/61338

 Fixed an issue with CCDA import validation, but does not address validation issues 
with reconciliation of medications, problems, allergies, or procedures. SPR 61810/
59244

Users must have the privilege “Change Electronic Prescribing Setting” to be 
able to set these parameters.

!!! If you have previously installed CCC Basic v1.1, do not install the CCC 
content included with the service pack. CCC Basic v1.1 includes newer 
content not present in the service pack.
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 The electronic and print versions of the CVS now contain the same sections. SPR 
61886/61828

 Performance enhancements to DTS processing. SPR 61527/61937

 Fixed an issue where LinkLogic would occasionally import insurance information 
in the reversed order of precedence. SPR 62178/60754

 Fixed an issue where the Care Provider on the CVS was listed as the user who 
created the document rather than the responsible provider of the document. SPR 
62179/61649

 When there are items on the CVS that are too long for the page, the text now 
wraps appropriately and the text size no longer shrinks. SPR 62476

 On the CPOE A&P-CCC form, the capacity of the drop-down field for problems has 
been approximately doubled. The total number of problems contained in the list is 
limited to about 80, depending on the length of the description and ICD codes 
included. SPR 62209/59444, SPR 62282

 On the Medication Administration HTML form, the NDC for the selected 
medication can now be selected from a drop-down if multiple NDC codes have 
been configured. The selected NDC code is also added to the comment field. SPR 
62211/60102

 Changes to the Immunization Management HTML form:

 The NDC for the selected vaccine now displays on the Administer window.  
The field is not editable in this window and must be configured using the 
Immunization Custom List Editor. SPR 57657/62280

 Entering an immunization on the form and selecting to auto-generate orders 
now correctly creates an Administration Order. SPR 62283/60022

 On the Immunization Management form, the Administered Date can now be 
the patient’s DOB. Previously, an error was given that the Administered Date 
could not be earlier than the DOB. SPR 62318/59793

 The 'Adverse Reaction' button has been removed from the 'Administer 
<Vaccine Group>' window.  An adverse reaction cannot be recorded until the 
immunization record has been committed.

 The 'Details <Vaccine Group/Series>' dialog (opened by clicking the green 
check icon), for an immunization with an adverse reaction already noted, now 
has two buttons; 'View Adv Reaction' and 'Edit Adv Reaction'.  

 Use the 'View Adv Reaction' button to open the 'Adverse Reaction for 
<vaccine group>' window. 

 Use the 'Edit Adv Reaction' button to open the 'Update Adverse Reaction' 
window.

 The 'Adverse Reaction for <vaccine group>' dialog now includes an 'Edit' 
button.  Use this button to open the 'Update Adverse Reaction for <vaccine>' 
dialog. SPR 62215/61441

 Lot Numbers may be entered in two ways: using Manage Lots to maintain 
lists of lot numbers with expiration dates, or free text entry of lot numbers.  
Lot numbers entered as free text are not 'remembered' for future selection.

 A checkbox enables use of Manage Lots.  The checkbox remembers each 
user's last selection.

 If Checked, the 'LM' (Lot Management) button is enabled and the Lot 
number field is a drop-down list of defined lots.  As before, selection of a 
lot number includes the expiration date.  Click 'LM' to open the 'Lot 
Management for <vaccine> dialog.
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 If unchecked. The 'LM' button is disabled.  The lot number can be entered 
as free text in the Lot # field.  The expiration date is entered as before. 
SPR 62213/61532

 When Lot Management is used, lots will eventually expire.  Now, these lots 
(numbers and associated expiration dates) will be automatically removed 
from the lot number list.  Scanning for expired lots will occur with the opening 
of any immunization custom list for the first time for the day by any user. SPR 
62212/61531

 There are two places where historical immunization records can be entered.  
Previously, for Preload, the name “Unknown” appeared at the bottom of the 
drop-down list of users.  This no longer appears. When using the Preload 
dialog to enter a historical record, the user may leave “Administered by” blank 
or they may select a user from the list. You may add a user to your system 
(such as “Unknown” or “External Immunization Provider”) as a substitute to 
indicate the individual is unknown or from another clinic. SPR 62216/59141

 Fixed an issue where a script error occurred while using the form. SPR 62214/
61998

 The Immunization History View and Letter no longer include lines for vaccine 
groups that were not given. SPR 58148/62281

 The SP7 release notes included partial information regarding the Clinical Quality 
Reporting v1.3 update. For complete details, refer to the CQR v1.3 release notes 
available on the services portal. SPR 62261 

 In order to export patient data for Clinical Quality Measure reporting, the Clinical 
Quality Measures Reporting subscription must be enabled and configured in your 
interface engine, and you must also have the Inquiries/Reports > Export 
Patients permission. SPR 62113

 Fixes for problem search:

 Results now include descriptions with special characters. SPR 62434/54197

 The quick search function now displays up to 10 results. SPR 62446

 The smart search filter now returns results if the keyword(s) phrase is longer 
than 15 characters. SPR 62435/52881

 ICD search now includes full synonym search capability. The next ICD and CPT 
updates after January 2015 must be installed. SPR 62455/54247

 Fixed an issue where an appended order created “Seen By” visit with Append and 
not with parent document ID. An order added in an append logged a “Seen By” 
visit with the append document and did not match with the numerator when the 
Clinical Visit Summary (CVS) was generated. SPR 62493/62735

This release corrects these contributing causes:

 A clinical visit summary attached to an order created within an append and 
logged as a “seen by” visit was not correctly associated with the parent visit 
by CQR and therefore not counted in the numerator. Appended encounters 
now always point to the parent document.

 If you were using custom document types for functional measures and 
identified an order code without a CPT- prefix, these codes were not sent to 
CQR. We automatically send for office visit , office procedure and home 
health visit, but other document types won’t be counted as Seen By. Now 
service orders matching orders in the GE Office Visit value set that have no 
prefix as well as those with CPT-, SCT-, SNO-, SNOMED-, or CDT- prefixes are 
sent. If a code with no prefix is a service order and it is in the value set, it is 
sent. SPR 62302

https://engage.gehealthcare.com/docs/DOC-109270
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 Fixed an issue where patients sometimes appeared in both numerator met and 
unmet counts for 13 Clinical Visit Summary (Stage 1). When a patient visit was 
appended using the full append option and selecting Document Type of Office 
Visit, the patient was counted twice in the denominator and only once the 
numerator even when a Clinical Visit Summary was printed for the original visit 
(parent document). If both the original and the appended document are office 
visits, each document is counted in the denominator; however, the appended 
Office Visit is counted as CVS unmet because the event of providing a Clinical 
Summary (printing, sending, declining) is only linked to the parent document. 

Now the chain of documents is counted as one encounter. SPR 62514/62737

 The application now checks for a valid service provider when generating a TOC. 
SPR 62872

Service Pack 7: New features and enhancements

Support for 14 additional Clinical Quality Measures
This release includes support for 14 additional Clinical Quality Measures, bringing the 
total of supported CQMs to 36. For detailed information about each measure and how 
to ensure you are capturing the correct data, see Achieving Meaningful Use with 
Centricity Practice Solution.

The CVS measure is based on “Office Visits” like the Electronic Notes 
Measure. You will know you have the problem if the denominators for the 
two measures are not the same. 

CMS50 / PQRS 374 Closing the Referral Loop: Receipt of Specialist Report
CMS56 / PQRS 376 Functional Status Assessment for Hip Replacement
CMS61 / PQRS 316 Preventive Care and Screening: Cholesterol - Fasting Low Density 
Lipoprotein (LDL-C) Test Performed
CMS68 / NQF 0419 / PQRS 130 Documentation of Current Medications in the Medical 
Record
CMS135 / NQF 0081 / PQRS 5 Heart Failure (HF): Angiotensin-Converting Enzyme 
(ACE) Inhibitor or Angiotensin Receptor Blocker (ARB) Therapy for Left Ventricular 
Systolic Dysfunction (LVSD)
CMS136 / NQF 0108 / PQRS 366 ADHD: Follow-Up Care for Children Prescribed 
Attention-Deficit/Hyperactivity Disorder (ADHD) Medication
CMS142 / NQF 0089 / PQRS 19 Diabetic Retinopathy: Communication with the 
Physician Managing Ongoing Diabetes Care
CMS144 / NQF 0083 / PQRS 8 GPRO HF-6 Heart Failure (HF): Beta-Blocker Therapy for 
Left Ventricular Systolic Dysfunction (LVSD)
CMS146 / NQF 0002 / PQRS 66 Appropriate Testing for Children with Pharyngitis
CMS153 / NQF0033 / PQRS 310 Chlamydia Screening for Women
CMS154 / NQF 0069 / PQRS 65 Appropriate Treatment for Children with Upper 
Respiratory Infection (URI)
CMS156 / NQF 0022 / PQRS 238 Use of High-Risk Medications in the Elderly
CMS160 / NQF 0712 / PQRS 371 Depression Utilization of the PHQ-9 Tool
CMS164 / NQF 0068 / PQRS 204 GPRO IVD-2 Ischemic Vascular Disease (IVD): Use of 
Aspirin or Another Antithrombotic
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PQRS updates to capture Medicare FFS (Part B) patient visits
This release includes the ability to associate an insurance carrier with a Source of 
Payment (SOP) code so patient visits are recognized for the PQRS program. CMS 
requires SOP data for all payers as part of the PQRS 2014 submission. In addition, 
providers participating in the PQRS program must satisfactorily report data on quality 
measures for covered Physician Fee Schedule (PFS) services furnished to Medicare 
Part B Fee-for-Service (FFS) beneficiaries. Medicare FFS patients are identified based 
on values in the primary & secondary insurance fields.

The following steps must be completed before February 7, 2015, when the PQRS 
reporting period ends.

Install Service Pack 7 in order to ensure the correct data is being reported for measure 
selection.

In order to simplify measure selection, we recommend that you apply Source of 
Payment (SOP) codes in a 2-part process. In part 1, apply only the Medicare FFS SOP 
code and any other non-Medicare SOP codes so the filter can help you easily 
determine if you have a qualifying FFS patient for each selected measure. In part 2, 
after selecting measures, we recommend applying the remaining Medicare SOP codes 
prior to measure authorization. Follow these steps by February 7, 2015 to perform the 
above:

Part 1

1 Complete insurance carrier associations using Medicare FFS SOP codes only & 
non-Medicare SOP codes. Do NOT apply any other Medicare SOP codes at this 
time.

2 Push updated information to CQR. Separate instructions for this step will be 
posted to the CQR page of the Service Portal: https://engage.gehealthcare.com/
community/en/cps/cqr. 

3 Within CQR, for each PQRS provider:

 Configure member setting to select all CQMs.

 If provider is also reporting for Meaningful Use, select appropriate stage & 
year.

 Calculate for reporting period January 1, 2014 - December 31, 2014.

 On dashboard, filter results for "Insurance:  Medicare".

 Review provider performance (using dashboard).

 For each provider, select 9 measures across 3 domains that each represent a 
significant Medicare FFS initial patient population or, if that is not possible, at 
least one Medicare FFS patient. At the very minimum, ensure at least one 
Medicare FFS patient in the initial patient population for one measure.

 Confirm valid consent forms have been submitted for each provider.

Part 2

4 Complete insurance carrier associations for remaining Medicare SOP codes.

5 Push updated information to CQR.

6 Within CQR, for each PQRS provider:

a Calculate for reporting period January 1, 2014 - December 31, 2014.

b On dashboard, filter results for "Insurance:  Medicare".


https://engage.gehealthcare.com/community/en/cps/cqr

https://engage.gehealthcare.com/community/en/cps/cqr
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c Review provider performance (using dashboard) one more time prior to 
submission to confirm zero errors.

For detailed information about performing these steps, review the webinar slides 
(updated January 23) and watch the recording of PQRS 2014 Capturing Medicare FFS 
Insurance available on the CQR page of the Service Portal: https://
engage.gehealthcare.com/community/en/cps/cqr

recorded webinar: https://engage.gehealthcare.com/videos/1730

updated slides: https://engage.gehealthcare.com/docs/DOC-96453

To complete the remaining required steps for the PQRS program, see additional 
instructions in the January 22, 2015 webinar on Measure Selection and Provider 
Authorization. The slides and recording are posted to the Service Portal.

Slides: https://engage.gehealthcare.com/docs/DOC-111789

Recording: https://engage.gehealthcare.com/videos/1745

MU 2014 Functional Measure changes (“MU SQL Patch”)
The following changes address MU 2014 workflows and data capture variations 
identified across our customer base. It updates how data is stored to ensure it is 
appropriately sent to CQR for calculations, revises how data is used in CQR, and also 
resolves relevant historical data so customers can calculate updated results.

Changes include SQL scripts that change how data is identified and gathered for 8 
Meaningful Use Functional measures and scripts that run nightly to address missing 
data in the MU Activity Log and make adjustments in what data is being sent to CQR. 
Data omitted previously is identified and sent, and data sent wrongly is set to Filed in 
Error on the CQR site so it will not be included in calculations 

After the update, the system resends all Functional measure (JSON) data sent from 
October 1, 2014 (the start date for reporting for Q4) to the time of application of the 
service pack. The Functional Measure subscription does not need to be changed for 
this to occur. However, if your reporting period begins before Q4, you can change the 
start date. For instructions and additional details, see "Optionally change epoch date" 
on page 85.

Performance and reliability updates 
Updates were applied to reduce the likelihood of JSON generation failing due to long 
running scripts. This risk is addressed by improving the efficiency of stored procedure 
processing and by changing the date range for data to be resent to CQR to October 1, 
2014 to the time of this service pack is applied. In the limited release, the system 
resent data from the time of upgrade to Centricity Practice Solution v12.0.x SPR 61986

Changes include the following:

MU_NightlyDataFixes nightly job

This new nightly job runs nightly at 8 pm per local server time by default and does the 
following:

 Updates data in appended docs to point to the parent visit or “seen by” document 
so that events recorded in appends can be counted for Meaningful Use. This 
ensures that Meaningful Use data for a provider that is included in an appended 
document is properly counted.

 Writes PATPORTALPIN observation term to the MUActivityLog so grants of patient 
access to portal are counted. SPR 61860

https://engage.gehealthcare.com/community/en/cps/cqr
https://engage.gehealthcare.com/community/en/cps/cqr

https://engage.gehealthcare.com/videos/1730

https://engage.gehealthcare.com/docs/DOC-96453

https://engage.gehealthcare.com/docs/DOC-111789
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Core Measure 1: CPOE for Medication, Laboratory and Radiology 
Orders (Stage 1 & 2)
The system now counts CPOE for the licensed/credentialed user who entered the lab 
or radiology order or prescription/refill. That person can be the Eligible Professional or 
a licensed/credentialed staff person. Previously, it counted CPOE only for the user who 
signed the document. 

Users who enter orders, such as Medical Assistants, need to be credentialed per their 
state, local, or professional guidelines.

Medications orders: If you use the Medication Administration form, Requested By 
provider should be the EP. Licensed/credentialed ancillary staff members can perform 
the administration and document the details and auto-generate the orders. 

Reprinting, re-faxing, historical prescribing methods, or zero quantity prescriptions are 
no longer counted in the denominator.

Lab/Radiology orders: Now only counts the licensed/credentialed user who enters 
the order and does not remove it from the numerator if the order is modified after it is 
signed, for example, when a Referral Coordinator updates the order with 
administrative information and sends it out. Previously, if a qualifying order was 
modified by someone not licensed/credentialed, it was removed from the numerator, 
counting against the EP. 

Orders entered in an Admin Hold state are also counted now.

Core Measure 2: ePrescribing (eRx) (Stage 2)
Otherwise qualifying electronic prescriptions will count as long as an eligibility check is 
received even if no formulary is available or if a formulary is linked to the patient's 
medical insurance. Previously, if the patient did not have a Surescripts formulary, the 
prescription was not be counted in the numerator of the measure, even though an 
eligibility check was done or another formulary was selected. 

Be sure to view the eligibility status to ensure that formulary response has been 
received within 24 hours.

Only prescriptions sent with Electronic prescribing method count in numerator. 

Core Measure 5 & Core Measure 7: Patient Electronic Access (Stage 1 
& 2)
System is now tracking and counting when PATPORTALPIN workflow is used to grant 
patients portal access. Previously, populating the observation term PATPORTALPIN 
was not included in MU Activity Log which resulted in under counting patients with 
portal access. 

See also "MU_NightlyDataFixes nightly job" on page 81, for more information about 
how PATPORTALPIN observations are counted.

Core Measure 13 & Core Measure 8: Clinical Summaries (Stage 1 & 2)
If a patient declines a Clinical Visit Summary (CVS), it is now counted in the numerator 
whenever recorded even if a document is signed at a later date, or recorded in an 
appended document. Previously, declines were incorrectly excluded from the 
numerator if the document was not signed within 4 days or if included in an appended 
document. 

Portal Access must be granted within 4 business days of the first visit in the 
reporting period.
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See also "MU_NightlyDataFixes nightly job" on page 81, for more information about 
how appended documents are counted.

Menu Measure 2 & Core Measure 10: Clinical Lab-Test Results (Stage 
1 & 2)
A new Chart Document View Structured Lab Results (MU) is used to determine which 
documents to count as structured lab results for the measure. Only documents with 
document types in this view that include structured lab results will count toward the 
measure. The view includes the Lab Report document type by default. Only use this 
document type for documents with structured lab results. 

After the service pack is applied, all documents created with this document type will 
be sent to CQR and count toward the measure. If you change a document to a 
document type that is not included in this view, it will be resent to CQR as Filed in Error 
and will not be not included in the calculations. 

Custom lab document types. After the service pack is applied, add any custom 
document types you use for lab reports to this view. When the document type is 
added to the view, any documents with that document type dating back to October 1, 
2014 (the start date for reporting for Q4) are automatically resent to CQR.

Issues corrected for this measure include:

 Structured lab results are counted if they are “pos”, “neg”, “positive,” or “negative”. 
Numeric values and the values “Y”, “N”, “Yes”, or “No” are also counted. SPR 61856, 
61861

 Preliminary lab results that are replaced with Final structured results are now 
treated as Filed in Error in CQR and not counted in either the numerator or the 
denominator. SPR 61239, 61252

 If the EP changes the lab report to a different document type, such as Pathology 
Report , to indicate that it does not contain structured lab results, it is no longer 
counted in the denominator. SPR 61854

In the LinkLogic LabLink interface, some HL7 clinical document codes are mapped to 
the Lab Report document type on import. You may also have custom cross-reference 
files that map document codes to this or other standard document types or to custom 
document types. Check your implementation and cross-reference files to make 
certain imported lab results with structured results are mapped to document types in 
the new Structured Lab Results (MU) view and that documents that do not include 
structured results, such as Pathology Report , are mapped to a document type that is 
not included in the view.

Menu Measure 7 & Core Measure 14: Medication Reconciliation 
(Stage 1 & 2)
Medication reconciliations for transitions of care are now counted when the EP 
manually checks the medication reconciliation box within an append to the office 
visit. See also "MU_NightlyDataFixes nightly job" on page 81, for more information 
about how appended documents are counted.

Menu Measure 3: Imaging Results (Stage 2)
A new Chart Document View Imaging Results (MU) is used to determine which 
documents to count as Imaging Results. Only documents with document types in this 

If your reporting period begins before Q4, you can adjust the range of data 
sent. See "Optionally change epoch date" on page 85. 
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view will count toward the measure. The view includes the Imaging Report document 
type by default. This document type should only be used for documents that include 
imaging results or links to imaging results.

After this update is applied, all documents created with this document type created 
will be sent to CQR and count toward the measure.

Custom imaging document types. After the service pack is applied, add any custom 
document types you use for imaging reports to this view. When the document type is 
added to the view, any documents with that document type dating back to October 1, 
2014 (the start date for reporting for Q4) are automatically resent to CQR.

Important . If you 1) only use Imaging Report document type for imaging results and 2) 
add any custom document types to the view, your measure results should be 
accurate. However, if Imaging Report is also associated with documents that are not 
imaging results, such as scanned written reports or PDF documents from a document 
management system, your results will be inaccurate. 

To correct this, identify any documents with Imaging Report document type that are 
not imaging results and associate them with a new document type that is not 
included in the Imaging Results (MU) view using Change Document Properties. When 
you change the document type to one that is not in the view, the document will be 
resent to CQR with a Filed In Error message so it is not counted in the measure.

In the LinkLogic ImageLink interface, some HL7 clinical document codes are 
mapped to the Imaging Report document type on import. You may also have custom 
cross-reference files that map document codes to this document type or other 
custom document types. Check your implementation and cross-reference files to 
make certain imported imaging results are mapped to document types in the Imaging 
Results (MU) view and that non-imaging documents are mapped to a document type 
that will not be included in the view.

Menu Measure 4: Family Health History (Stage 2)
System now counts when EP checks No Known Family History for a first degree 
relative. This corrects a known issue for documenting Family History in the released 
product.

Confirming data updates to CQR
After the service pack is applied, Functional Measure data will be resent to CQR. Once 
data is ingested, you can recalculate your data. 

1 Apply the service pack update and restart JBoss before subscription processing 
begins for the day.

If your reporting period begins before Q4, you can adjust the range of data 
sent. See "Optionally change epoch date" on page 85. 

To ensure all data sent to CQR is corrected, this update resends data from 
October 1, 2014 (the start date for reporting for Q4). This increases the size 
and duration of the MU Functional measure data feed on the first run after 
this update is applied. 

If your reporting period begins before Q4, you can adjust the range of data 
resent. See "Optionally change epoch date" on page 85. 
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2 If appropriate, change the date range for data to be resent. See "Optionally 
change epoch date" on page 85. This step should also be accomplished before 
subscription processing begins.

3 Wait over night for new nightly jobs to run, functional measure subscription to 
process data to be resent, and Qvera Interface Engine to send queued data.

4 After 9 am the following morning (or whenever QIE processing is scheduled to 
complete in your environment), log into CQR as administrator or Quality 
Champion. 

5 Go to Member Insight > Data Ingestion tab to and check if ingestion is complete.

6 Next, look above this list at the Last Received Data value to determine when the 
last CCDA was ingested. 

7 Wait at least 4 hours after the last CCDA was ingested and then click Calculate 
Now. 

8 Wait another 4 hours and then check your results on the Dashboard. 

Optionally change epoch date
To ensure all data sent to CQR is corrected, all Functional measure (JSON) data is 
resent sent from October 1, 2014 (the start date for reporting for Q4) to the time of 
application of this update. This increases the size and duration of the MU Functional 
measure data feed on the first run after this update is applied. 

Moreover, whenever you make changes to Document Views used by Imaging Results 
and Structured Lab Results, the data feed will include information for document types 
added or removed back to the date you upgraded.

If your reporting period begins before Q4, you can change the start date. 

What is my epoch date?

Run this SQL query:

If providers in your organization use different reporting periods, use the 
earliest reporting period.
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select value from symbol where 
object='MU_Functional_epoch_date' and name='Date'

How do I update the epoch date?

Run these SQL statements using date format 'mm/dd/yyyy' for the start of your 
reporting period:

update symbol set value='MM/DD/YYYY' where id=2 and 
object='MU_Functional_epoch_date' and name='Date';

Service Pack 7: Fixed issues

The following issues have been addressed in this release:

 EPID has been added to the CCDA generated for CQR. SPR 61185

 Fixed an issue where, on the CCDA, prescribed medications were listed as 
“ordered” instead “active”. SPR 61205/59103

 The start/stop dates of medication orders on the CCDA are taken from the 
prescribing/refill time rather than from the medication duration date. SPR 61207/
59173

 Insurance carries now load correctly when using System > Load Insurance 
Carrier > Search. SPR 61259/61255

 The CCDA now includes the Risk Category Assessment category in the Procedure 
subsection of the Results section. SPR 61317/59226

 On the CCCDA, the Procedure and Performed stop and start dates for GE Negated 
Observations are now the same. SPR 61318/59954

 Fixes an issue where a CVS created for one patient was attached to a document 
on a different patient. SPR 61800/60572

 The FH-SH-CCC form no records “No Known Relative” and “No Known Family 
History” as a first degree relative to allow for adopted patients to get credit for MU 
Family History measures. SPR 61858

 Fixed an issue where the Care Provider on the CVS was listed as the user who 
created the document rather than the provider of the document. SPR 61649

Service Pack 6: Important Product Notifications

CPS 12.0.2 - A chart can be Merged even if multiple users have the 
source or destination chart open
When two users have the same source chart open one of them can merge this chart 
into another chart. When this is done the second user is not notified and can continue 
to Start Updates and add and sign clinical data.

Resolution: When merging patient charts, the application now checks if another user 
has the same patient chart open. SPR 60594

immun_getlist() is not showing immunization for Synagis CVX code 93
The MEL symbol immun_getlist() was not showing immunizations for CVX code 93 
because the vaccine group was not entered in the Imm_VaccineGroupName table. 

!!! Administrators and Risk Managers should review these Important Product 
Notifications for details about critical product functionality fixes.
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Resolution: The vaccine group RSV-MAb has been added to the Immunization 
Management form. SPR 60663

Immunization migration missing factory obs to be migrated
Some immunization obs terms were not included in initial migration.

Resolution: More vaccines from the factory obs kit are now included in the 
geimmunizationsmap.csv spreadsheet, including all vaccines explicitly used by the 
Immunization Management form. However, some vaccines are not in the spreadsheet 
and, if you use them, are not migrated. These vaccines can be added to the custom 
immunizationmap.csv file. Re-running the tool will add the missing vaccines. A list of 
obs terms from the factory kit that are not migrated is available upon request. SPR 
60731

Immunization tool associating wrong vaccines with patients and not 
migrating all data
When migrating data using the Immunization Migration tool, incorrect vaccines are 
reported for patients and not all data are migrated. 

Resolution: Fixed an issue where Immunization Migration tool associating wrong 
vaccines with patients and not migrating all data. SPR 60737

Incorrect HDIDs in geimmunizations spreadsheet
HDIDs for many vaccine attributes were missing or incorrect in the original 
spreadsheet.

Resolution: All HDIDs in the geimmunizationsmap.csv spreadsheet now correspond to 
observation terms from the vaccine group (1246) in the factory observations kit. All 
observation values are collected in reference to a migrated vaccine, including 
attributes such as Reason Not Given, Adverse Reaction, Administered Date, and so on. 
Previously, correct HDIDs for many vaccine attributes were missing in the original 
spreadsheet. If you already migrated production data, re-running the tool will pick up 
missed Adverse Reaction and Reason Not Given attributes, but other attributes are 
not recovered. SPR 59659, 60741

Service Pack 6: Fixed issues

 Changed the behavior of the GET_MUActivity_Log data symbol so that printing 
must always finish before the log is retrieved. SPR 58925

 Immunization Migration tool now creates a required index that prevents slowness 
previously experienced by some customers without timing out. The tool creates 
an index on the OBS table required for faster performance. Previously, the index 
had to be created manually on OBS.OBSID. SPR 59296,SPR 59458

 Vaccine groups on the Immunization Management form now appear on the text 
translation. SPR 60127

 All vaccines entered on the Immunization Management form now appear on the 
document view. SPR 60141

 CVS documents now inherit the confidentiality settings of the parent document. 
SPR 60165

 The Location of Care for a document is retrieved from the associated location. SPR 
60220

 Various stability fixes. SPR 60217, SPR 60263, SPR 60552, SPR 60598
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 TOC documents now inherit the confidentiality settings of the parent document. 
SPR 60435

 Fixed an issue where an instance of a patient visit is open at the same time an 
instance of a patient billing is also open would generate a system error when the 
visit is saved. SPR 60525, SPR 60609

 Registries created in LinkLogic now show on the Registry tab. SPR 60562

 Uninstalling a CPS website on a JBoss server with multiple CPS websites no longer 
causes a crash when searching for problems in Chart. SPR 60567

 When generating a statement for a patient who has a balance under two 
companies, statements are generated for both companies. SPR 60568

 Significantly improved performance is expected with a change to the tool design 
that eliminates the need for the DM_MIGRATION_OBS_MIGRATED table to back up 
migrated rows from the OBS table. Previously tool performance was degraded 
and consumed more I/O resources than necessary, especially when running with 
parallel threads. SPR 60569

 If a patient chart is open and has no updates in progress, users can now print 
documents from the desktop. SPR 60578

 Only active medications are displayed in the update medications dialog. 
Removing a medication no longer causes a duplicate listing. SPR 60587

 After using the Medication Administration form the Medications tab no longer 
includes duplicates. SPR 60590

 Uncoded medications are no longer counted for CPOE measure calculations. SPR 
60601

 Fixed an issue where multiple instances of the same patient visit would crash the 
application when the visit is saved. SPR 60608

 The Immunization Migration Wizard now correctly ignores time information in the 
adverse reaction field. SPR 60620

 Now able to generate an on Demand Statement for an account that has a credit 
balance. SPR 60637

 Fixed an issue where a resource does not get released properly, and causes a 
resource leak. SPR 60640

 All vaccines entered on the Immunization Management form now appear on the 
text of the chart document. SPR 60658

 The Data Migration tool now migrates “pneuped (Prevnar unspecified)” to CVX-
152. SPR 60666

 Fixed an issue where an order number is not being generated for every order. SPR 
60673

 On the Immunization Management form, administering Proquad now indicates 
that Varicella, Measles, Mumps, and Rubella have been administered. SPR 60676

 The Immunization Management history view now lists Measles, Mumps, and 
Rubella individually when an MMR is given. SPR 60681

 The Immunization Management form now produces a text translation in the chart 
note. SPR 60682

 Growth chart data point tool-tip popup now shows correctly in Internet Explorer 
10. SPR 60707

 Fixed an issue where CCDAs generated allow invalid values for ethnicity codes. 
SPR 60713
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 Fixed an issue where Immunization Migration Wizard generates undetermined 
vaccines. SPR 60727

 Changes to the Common Event Model default parameters for stability and 
performance enhancements. SPR 60733

 Common Event Model configuration parameters are now editable in the JMX 
console. SPR 60734

 The Immunization Migration tool now evaluates additional values in determining 
whether an immunization Was Given. A separate post-processing SQL script is 
available to clean up Undetermined vaccines if you already migrated data. The 
script can also be customized to look for values unique to your site. SPR 60740

 Enhanced Administered Date calculation. The tool first checks to see if a valid 'AD' 
value exists. If so, that date is used. If not, it parses the main observation value for 
a date, and uses that if found. Otherwise, it uses the obsdate of the main 
observation. SPR 60743

 Fixed an issue where vaccines for Reason Not Given or Adverse Reactions are not 
migrating. SPR 60744

 Fixed an issue where clicking Rx Refill would hang and crash the application. SPR 
60845

 Redesigned CVS layout so that it is easier to read. The header (patient information) 
is clearly separated from the rest of the CVS sections and content. SPR 60962, SPR 
60964

 CVS preview now matches CVS printout. SPR 60965

Service Pack 5: Fixed issues

 Combo vaccine series are now calculated for the Immunization History View and 
Immunization Letter consistent with the Immunization Management form. SPR 
59929

 The installer no longer fails with the error “Foreign Key Constraint 
‘FK_PatientRace_PID’”. SPR 60034

 Opening multiple list views no longer causes application crashes due to “out of 
memory” errors. SPR 60331

 The Clinical Visit Summary now prints only information from the current visit 
except for problems, medications, and allergies. Previously, all previous visits were 
included for all categories. SPR 60383

 Fixed an issue where CPT codes were being incorrectly identified as SNOMED in 
the CCDA. SPR 60385

 The client installer now correctly places registry values in the correct registry for 
64-bit operating systems. SPR 60459

 Fixed an issue where payment entry gave an error and caused an application 
crash. SPR 60446

 Applying the July Knowledgebase update after applying the June ICD and CPT 
codes no longer causes the Knowledgebase update to fail. SPR 60349
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Service Pack 4: New features and enhancements

Disable or enable contraindications

New functionality in this release lets users disable and enable drug-gender, drug-age, 
and drug-problem contraindication checks.  Three flags let customers independently 
turn off and on drug-gender, drug-age, and drug-problem contraindication checking 
in the client on the JBoss JMX Console. 

1 To access JMX console go to

https://<your_server-name>:9443/jmx-console

where your_server-name refers to your JBoss Application Server name.

2 Log in as user admin with password cpAdm1n. This is the default login. Use your 
own configured credentials if they are different.

3 Select the com.gehcit.cp.<deploy-id> link under Object Name Filter to display 
available JMX beans in the right pane.

4 Next, select the DrugInteractionService node (shown below).

You’ll see three types of contraindication checking alert that can be excluded 
(shown below): 
DrugAgeCheckingEnabled
DrugGenderCheckingEnabled
DrugProblemCheckingEnabled 

5 Choose False for each type of contraindication checking alert you want to 
exclude, and then click on Apply Changes. (Default setting for all flags is True.)

!!! This is a global configuration change that allows you to turn off any 
combination of Drug – Problem, Drug – Gender, or Drug – Age 
contraindications for your site. It does not affect how users see Drug - Drug or 
Drug - Allergy contraindications.

If the client application is open during flag changes, it must be restarted 
before the changes are reflected.
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This change is immediate and does not require a JBoss restart. All flag changes 
are logged to <DeployId>.CentricityPractice.log.

Enable CCDA validation

This will enable the CCDA validation before CCDAs are sent to CQR. The invalid CCDAs 
will be written to C:\Program Files\Centricity Practice Solution\jboss\server\default\log 
folder with the extension “xml”.

1 Click ClinicalDocumentService.

This section is required only if your site has a live interface to our production 
CQR environment.
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2 Click True, then Apply Changes.

Modify CQR channels in QIE

1 Download the latest channel from Qvera at: www.qvera.com/ge-oem-cqr-
download.html. The latest CQR channels are in the file cqrConfig-2014-07-11.zip, 
which will begin downloading automatically.

2 When importing the configuration, under Web Service Connections, uncheck the 
boxes that you do NOT want the web service URL/username/password to change.

3 Checking Clinical Quality Reporting web service connection will update the PIL 
endpoint to Production URL.

4 Check Overwrite Endpoints so the settings inside the channels will be updated.

This section is required only if your site has a live interface to our production 
CQR environment.

www.qvera.com/ge-oem-cqr-download.html
www.qvera.com/ge-oem-cqr-download.html
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Service Pack 4: Fixed issues

 Race information for “White” and “Native Hawaiian or Other Pacific Islander” were 
being removed from the database when upgrading to Centricity Practice Solution 
12. SPR 60190

 Upgrading to Centricity Practice Solution 12 was causing Foreign Key constraint 
errors. SPR 60212

 Recover race entries for “White” and “Native Hawaiian or Other Pacific Islander” 
that were removed from the database when a site upgraded to two builds of CPS 
12; for example, a site installed CPS 12.0 and then upgraded to a later version of 
12.0 or to an unpatched service pack. SPR 59449

 The application crashes with the error message “Error occurred in class , method 
CChartSummaryTabView::onUIRefresh”. SPR 60202

 Combo vaccines that had some of the series entered prior to installing the 
Immunization Management HTML form now track the correct series number. SPR 
60203

 Users are seeing too many drug contraindication results, specifically drug-
problem, drug-age and drug-gender contraindications. These displays make it 
more difficult to see truly critical health alerts and causes alert fatigue. 

To reduce the number of contraindications, users can optionally exclude three 
less critical drug contraindication types in the JMX console under JBoss. This 
configuration option will be available in the application user interface in the 
forthcoming release. See “Use JBoss JMX Console” on page 15 of the Service Pack 
4 release notes. SPR 60204

 Some customers have experienced a failure when the QIE interface engine pulls 
data from Centricity Practice Solution to send to the CQR server. When this occurs, 
the WebService requests made by the QIE server get locked up in requests to the 
ActiveMQ queuing system, which causes QIE to timeout and retry the request. 
These requests pile up and use all the threads available in the JBoss server, 
making the server unable to respond. SPR 60208

This release includes a change to update to a newer version of Active MQ which 
addresses these issues.

Service Pack 3: Fixed issues

 Fixed an issue where LinkLogic created documents when importing appointment 
messages when it was configured not to. SPR 53957

 The Immunization Management HTML form no longer gives errors if the CVX code 
is empty. SPR 59087

 Added details for counting ePrescribing events towards measures to the 
Meaningful Use Guide. SPR 59147

 Generated CCDA documents are now validated before exporting to CQR. SPR 
59187

 Stop times can now be entered for Functional Measure subscriptions. SPR 59193

 The FH-SH-CCC form no longer translates inactive records into the chart note. SPR 
59195

!!! When redeploying the Service Layer you must re-install CCC Basic and 
other HTML form content on all deployments.



CPS v12.0.12 Release Notes

94

 Line breaks are now removed from lab results, preventing CCDA validation errors. 
SPR 59199

 Race subcategories are now included in CCDA calculations. SPR 59204

 Invalid characters no longer appear in the CCDA, causing validation failures. SPR 
59208

 Invalid document types no longer cause CCDA failures. SPR 59211

 Revised information in several workflows in the Meaningful Use guide. SPR 59220

 Modified the signature of the ADD_MUACTIVITY_LOG() method to make it easier to 
use and more relevant for form developers. SPR 59254

 Problem search in custom lists and quick search now includes results where the 
term is contained as a word anywhere in the description as long as it is a word by 
itself and not a suffix. For example, a search for “pain” will return results for head 
pain, stomach pain, hip pain, etc. It will not return results where “pain” is not a 
separate word such as “hippain”. SPR 59266

Service Pack 2: Important Product Notifications

The Immunization Migration tool can incorrectly set “was given” and 
“administered by” when importing
For a given vaccine, the migration tool loops through every time the vaccine was 
given. For each vaccine, the tool attempts to find who administered it . If the tool finds 
an obsterm for the hdid associated with “given by” or “admin by” it sets the vaccine as 
“was given”. If there is no entry for either of those hdids, the value for the last patient 
that had an observation for those hdids is used. This caused the “was given” and 
“administered by” being set incorrectly.

Resolution: The “administered by” value is now set to NULL when there is no entry for 
“given by” or “admin by”. SPR 59105

DTS is forced to match on external ID after importing a fax status 
document from Biscom
Biscom uses a generic name of FAX STATUS for the patient name so it is forced to 
match only on external ID.  After the DTS imports one of these .HD files from Biscom, it 
tries to match every import on external ID only, which generates patient matching 
errors.

Resolution: Forced account match mode is now turned off when any interface uses 
an external ID set. SPR 52515

Service Pack 2: Fixed issues

 On the Immunization Management HTML form, the Preload function now stores 
the data to history. SPR 57803

 On the Immunization Management HTML form, the blue question mark can now 
be used multiple times inside the form. SPR 58146

 Care Alert warning messages now display on top of other windows so the user 
must acknowledge it before continuing. SPR 58320

 Invalid email addresses no longer cause CCDA validation errors. SPR 58673

!!! Administrators and Risk Managers should review these Important Product 
Notifications for details about critical product functionality fixes released in 
this version.
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 Invalid characters are now removed during CCDA document generation. 
Previously, invalid characters were being included, causing NIST validation to fail. 
SPR 58704

 Fixed an issue where Immunization data converted from OBS data would contain 
units that caused the CCDA to fail validation. SPR 58706

 CCDA generation no longer fails if there is not a responsible provider. SPR 58711

 JBoss completes processing a CEM job for patient charts with certain observation 
values that previously got stuck being processed. SPR 58712

 The FixGroupID script now runs successfully if there are documents “Filed in Error”. 
SPR 58715

 Clinical Visit Summary prints all problems, medications, and allergies, but only 
items from the current visit for other entries. Previously, all previous visits were 
included for all categories. SPR 58774

 CCDA no longer fails validation if the observation unit is empty. SPR 58781

 If a new Immunization or Med Admin custom list has been created by copying a 
factory custom list and editing it , there is a risk of it being broken when installing a 
quarterly Full Knowledgebase update. To prevent data loss, prior to installing the 
next Full Knowledgebase update, for each Immunization and Med Admin custom 
list:

a Open the Custom List editor in CPS Admin.

b Make a new copy of the custom list and give it a a new name.

c Remove the old custom list.

d Rename the new custom list to the original name.

SPR 58783

 Language codes are now correct in the CCDA. SPR 58787

 CCDA generation no longer fails if observations have no value. SPR 58788

 Immunizations with NDC codes that contain hyphens now migrate correctly. SPR 
58789

 Dosage and units are now migrated correctly when they are entered as a single 
value with one obsterm. SPR 58790

 The CQM Query to load events on a new system no longer times out when 
processing a large number of charts. SPR 58792

 The Functional Measure query generates successfully when processing a long 
date range. SPR 58794

 Changes made in the Select Printers window are now remembered correctly. SPR 
58816

 The Immunization Management form no longer gives a script error when loading 
the form in charts that contain migrated immunization data. SPR 58848

 Copying factory lists in the Custom List Editor now correctly sets the owner to “C” 
for custom. SPR 58856

 The MU Checklist form now correctly records height and BMI for a visit if the 
values are the same as previously. SPR 58863

 ICD-9 codes now convert to ICD-10 codes correctly when updating from previous 
versions of CPS. Previously, some codes were showing as SNOMED codes. SPR 
58868
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 The Immunization Migration tool now migrates items with invalid VIS or NDC 
codes. When an invalid VIS or NDC is encountered during migration, they are 
listed as “null” and the original is appended to the Admin Comment. SPR 58936

 When the Immunization Management tool encounters entries with invalid VIS or 
NDC codes it now migrates them and sets the values to NULL and appends the 
original to the Admin comment. Previously, the tool flagged these as invalid and 
did not migrate them. SPR 58939

 When the Service Layer is configured to “Disable Interfaces” the service layer now 
loads properly. SPR 58945

 eRx renewal requests now match items on the active medication list based on 
GPI, reducing the risk of mismatches. SPR SPR 58947

 Do not use Stop Date on custom forms using the immun_add, immun_update, 
and immun_getlist data symbols. Immunizations created with a stop date are not 
exported in the CCDA and are not counted for CQMs. SPR 59013

 Print handouts now increment the numerator for option (ii) of MU Stage 2 patient 
education with handouts. SPR 59018

 Language codes that contain invalid or non-standard entries are now listed as 
“unknown” when generating a CCDA. SPR 59043

 During CCDA validation, if anything other than the five valid race codes are used, 
the Primary race code is set to “unknown” and the entry in the patient record is 
added as a secondary race code. SPR 59046

 Lab results with line breaks no longer cause a CCDA validation failure. SPR 59049

 The “doseQuantity” value in the CCDA no longer contains extraneous decimal 
units. SPR 59052

 Medication precondition codes with spaces no longer cause a CCDA validation 
failure. SPR 59056

On the Review Electronic Prescriptions screen, the Authorizing 
Provider changes to the logged in user and the prescription cannot 
be sent.

Resolution: A signing provider with the Access Electronic Prescribing privilege 
can create, sign, and send an electronic prescription authorized by another 
provider. As long as the signing provider is not the Responsible Provider for the 
document, when they sign the prescription they are listed on the Review 
screen as Prescribing Agent along with the Authorizing Provider. However, a 
Prescribing Agent cannot electronically prescribe medications for more than 
one authorizing provider in a single update. You must change the medications 
to a single authorizing provider or create separate updates for each 
authorizing provider. SPR 58817

Service Pack 1

Not released.
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